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What is Axon?

Axon is a simulation of the classic Hodgkin-Huxley (1952) model for axon excitation 
formulated from their voltage clamp measurements upon the squid axon.  It 
provides you with a simulated excised peripheral nerve from a squid and allows 
you to perform experiments by setting the environment of the axon, applying 
stimuli or clamps, and generating one or more action potentials.  Using the tools in 
Axon you can create experiments which explore a variety of nerve properties, such 
as threshold, refractory period, accommodation, and summation.

Axon is not meant to replace work with real organisms.  It offers no practice in 
tissue dissection, but does direct attention to the physiological properties of an actual 
axon.  In addition, it provides insight about the hypothesized mechanisms of 
excitation in a way that is not practical with animal preparations.

What  You Should Read

If you are unfamiliar with the Macintosh computer:
Read the next section What You Need to Know to Read this Manual.

If you want to know whether or not you have the right equipment to run the 
program:

Read the Appendix entitled Hardware and Software Requirements.

If you are familiar with the Macintosh but not with this program:
Read the section entitled A Tour of Axon.  There are three tutorials presented in 
this section.  Tutorial Problem #1 gives a basic tour of the Axon program, 
covering everything you need to know to start and run a simple experiment.  
Tutorial Problem #2 goes into more detail on some of the more complex features 
of Axon, particularly the membrane cartoon.  Tutorial Problem #3 discusses the 
use of voltage clamps.

If you would like some additional exercises and problems:
Read the Appendix entitled Exercises or the Appendix entitled Additional 
Problems.

If you want to get started right away and you already have the program running:
Read the section entitled Doing a Basic Experiment.

If you've  been through the Tour of Axon and you want more information:
Read the section entitled Reference.

If you started by skimming the manual but have found something that doesn't 
seem right:

Read the section entitled A Word of Warning, the Appendix entitled It Doesn't 



Work!, or consult the index.

What You Need to Know

We assume in this manual that you are already familiar with the basic set of 
standard Macintosh terms and operations.  If you are not comfortable with these, 
you should work with the Macintosh Owner's Guide or another introduction to the 
Macintosh before you begin.  Better yet, grab somebody that looks like they know 
what they are doing, show them this list of words and ask them to explain what 
each of them means.  The terms you need to be familiar with are window, menu, 
mouse, point, click, shift click, drag, and double click.   If you understand these , you 
are ready to get started.  Before long, however, you will also need to know several 
more Macintosh vocabulary words close box, zoom box, grow box, title bar, scroll bar, 
clipboard, and desk accessory.

We also assume that you know how to start a program running.  If you think you 
know how, but you experience some difficulty, look at the Appendix entitled, It 
Doesn't Work!, for suggestions that we hope will help.

A Word of Warning

It is possible that what you read in this manual may not accurately reflect what you 
see on the screen as you use the program.  There are two basic reasons for this.  First,  
Axon is not yet a final product. It is changing as we try to add new capabilities to the 
program and as we improve it in response to the experience of preliminary users 
like yourself.  The manual you are reading may have been written to go with a 
different version of the program than the one you are using.  If you suspect that this 
may be the case, refer to the Appendix entitled It Doesn't Work!.  It will tell you how 
to check for this problem. 

The second reason for a conflict between the manual and the program is intrinsic in 
the design of Axon itself.  Problems may be completely customized to the needs of 
the user.  This means that the selection of problems you have to work with will 
possibly not be the same as the examples in this manual. There are several sorts of 
differences that may be due to customization of the problems 

• Different methods may be used to calculate the results of the 
experiment.  This means that numbers in the table may vary from 
given examples (but should not do so significantly!).

• Some of the illustrated options or tools may not be available to you.  
For instance, a particular problem may or may not include a membrane 



cartoon, or a data table.  You may have controls for both stimuli and 
clamps or just for one of them.  The manual attempts to cover all of 
the options which may be available, but you may not find the exact 
configuration of your problem.  If you have an option which is not 
covered in one of the Tutorial Problems, look in the Reference section.



A Tour of Axon

There are three tutorials presented in this section.  Tutorial Problem #1 gives a 
basic tour of the Axon program, covering everything you need to know to start 
and run a simple experiment.  Tutorial Problem #2 goes into more detail on 
some of the more complex features of Axon, particularly the membrane cartoon.  
Tutorial Problem #3 describes the use of voltage clamps.

Tutorial Problem #1 - Introduction

This tour of the Axon program will serve as an introduction to the basic techniques 
for running an Axon simulation.  You will learn how to:

•  Start the program

•  Choose a problem environment to work with

•  Setup and run a simple experiment

•  Look at your data

•  Save the results of your experiment.

Starting the Program 

To start the program, double click  on the Axon program icon (move the mouse 
pointer over the icon and click the button twice in quick succession).  

Figure 1.
The Axon Program Icon

The Problem Selection Window

When you start the Axon simulation, the first window you will see will be a 



Problem Selection window.  In most cases, this window will be similar to the 
window in Figure 2.

Figure 2.
Problem Selection window.

If your version of Axon has problem editing enabled, then your window will look 
more like Figure 3 below, with several buttons on the left instead of a picture of an 
axon.  In either case, the procedure for selecting a problem to run is the same.  
Problem Editing will be discussed in the Reference section.  For now, you can ignore 
the buttons on the left if you have them.



Figure 3.
Problem Selection window, with editing enabled.

On the left hand side of the problem selection window is a list of the available 
problems.  Each problem represents a "micro-world" within which you will design 
and implement an experiment in axon physiology.    The problems have been 
designed to present different aspects of neurophysiology or to illustrate particular 
problems.  We will begin our tour with the problem labelled Tutorial Problem #1, 
which demonstrates how you would go about setting up and running a simple 
experiment in Axon.  Tutorial Problem #2 demonstrates some techniques for 
investigating more complex aspects of the axon, including the use of the membrane 
cartoon.

(Note:  The list of problems on your screen may not be exactly the same as the list in 
the illustration above.  Some of the original problems may have been renamed or 
deleted or new problems may have been added.  If Tutorial Problem #1 is missing, 
just select another problem.  The basic principles for setting up and running an 
experiment will be the same, although your screens may look a little different.)

To select a problem, move the cursor until it is over the problem you want to use 
(in this case, move the cursor over Tutorial Problem #1) and click.  The selection 
should turn dark.  To open the problem, either click on the Start Problem button 
(bottom right corner of the screen) or double click on your selection.  The Problem 
Selection window will disappear and an Experiment Summary window for this 
problem will take its place.

The Experiment Summary Window



Associated with each Axon experiment is an experiment summary window, shown 
in Figure 4.  Using the tools in this window you will set up the experiment 
parameters, run one or more experiment trials, and display the results.  Once your 
experiment has been run, you can use the window's tools to look at your data in 
different ways, take notes on your experiment, and export your notes or your data to 
other programs for further analysis.  

Figure 4.
Experiment Summary Window.  The summary window for Tutorial Problem #1.  Experiments are set up, 
controlled, and the results displayed using the tools in this window.

There are four major components to the experiment summary window for Tutorial 
Problem #1:  the Graph Region, the Stimuli Controls, the Data Table, and the 
Experiment Controls (see Figure 5, below).  (Not all problems will setup the 
experiment summary window with these components.  Some problems may use 
other controls or displays instead of or in addition to the ones used here, depending 
on the factors to be investigated in that problem.  See Tutorial Problem #2 for an 
example of a problem which uses the membrane cartoon.  All of the controls and 
displays which are available are discussed in the Reference section of this manual.)



 Figure 5.
The Summary Window for Tutorial Problem #1. Four regions are important:  the Graph Region, which 
displays dynamic data plots; the Data Table, which stores data for the current experiment trial; the 
Stimuli Controls, which allow the changing of stimuli parameters; and the Experiment Controls, 
which control the running of the experiment.

The Graph Region will display your data as your experiment runs.  The Data Table 
contains all of the data generated from the current trial of the experiment.  You can 
scroll the table to read values after the trial has finished.  The Stimuli Controls are 
used to modify the stimulus parameters.  The Experiment Controls are used to start, 
stop, or continue an experiment trial; to start a new experiment trial; and to switch 
back and forth between trials which have already been run.

Running a Simple Experiment

In this part of the tour we will run a simple experiment to examine the effect of 
different sized stimuli on the development of an action potential in a simulated 
squid axon.  Our experiment will involve running three separate trials.  In each trial 
we will stimulate the axon with a supra-threshold electrical current and watch the 
development of an action potential.  We will select a different intensity and 
duration of the stimulus on each trial, run the trial, and collect our data.  Using the 
tools in the Experiment Summary Window we will see how we can display our data 



in a variety of ways, make notes on our observations, and even export our data and 
observations for further analysis.

Running One Trial

Before we start, let's take a look at the stimulus for the current trial.  Before a trial is 
run, all of the stimuli which have been setup are displayed on the graph (Figure 6).

Figure 6.
A single square-wave stimulus displayed on the graph of the experiment summary window.  The 
Stimuli Controls are underneath the graph.

For this experiment we will have a single "square wave" stimulus, plotted on the 
graph as intensity of stimulating current (iStim) versus Time.  The start of the 
stimulus is indicated by the dotted line.  The intensity of the stimulus is measured 
along the y–axis and the duration along the x-axis. The start, intensity, and duration 
of the stimulus are also displayed numerically in the boxes in the Stimuli Controls 
area underneath the graph.  For our first trial the stimulus will be turned on at 0.50 
msec and will be applied for 0.10 msec at an intensity of 100.00 µamps.  (As we will 
see later, the intensity, duration, and starting point of the stimulus can be changed 
by dragging on the small black boxes (handles).)  On the far left of the Stimuli 
Controls area is the Stimulus Well.  Additional stimuli can be added to the graph by 
clicking on one of the small symbols and dragging it onto the graph.  In this 
experiment we will only use the one stimulus which is already drawn on the graph.  
(If you experimented with the Stimulus Well and now have more than one 
stimulus on the graph, simply click on the small handle on the x-axis and drag the 
handle out of the graph area.)  For more information on adding and deleting 
stimuli see the Reference section.

In addition to the "square wave" stimulus it is also possible to add "ramp stimuli" 



to the experiment.  We won't complicate our experiment with these different 
shaped stimuli at this time, but you can find a more complete discussion of ramp 
stimuli in the Reference section.

The scale for the x-axis (time) is displayed in the box on the far right, underneath the 
horizontal axis.  For this experiment the maximum time is set to 10 msec.  Each trial 
will automatically stop after 10 msec.  Because it is possible to plot several kinds of 
data on the vertical (y-axis), each of which might have a different scale, the scaling of 
the y-axis is more complex.  We will leave the discussion of y-axis scaling for later in 
this tutorial (see Scaling the Y-Axis below).

Click the Start button to start a trial. The stimulus which was drawn on the graph 
and the Stimuli Control boxes will disappear.  The label in the start button will 
change to Stop.   As the simulation runs, the data will be plotted on the graph as 
dotted lines.  Allow the simulation to run for a short time and then click the Stop 
button.  Notice that the button becomes gray (inactive) and the button label changes 
to Continue.  When the simulation is no longer running, the data (the axon 
membrane potential, or E, and stimulus intensity, or iStim) are redrawn in black.  
Click Continue and allow the simulation to finish.  The new data will again be 
drawn as dotted lines.  Notice that when the simulation has run for the maximum 
time set on the x-axis, it will automatically stop and the Start button will become 
inactive.

Notice also that the title of this trial, Trial 1, appears in the popup menu at the left of 
the Experiment Controls region.  The title of the current trial is always displayed in 
this box.

Looking At The Results

At this point your screen should look something like the screen in Figure 7.  The 
data for the trial we just ran (Trial 1) are plotted on the graph and displayed in the 
data table.



Figure 7.  
The experiment summary window after running one trial of an experiment.  The title of the current trial 
is displayed in the trial popup box.

On this screen, the data table has been sized so that only a single row of data is 
visible.  However, it is possible to change the size of the table using the Pane 
Control.   The Pane Control is the small, black rectangle on the upper, right hand 
corner of the data table (see Figure 8).  

Figure 8.
The Pane Control

Move the cursor over the pane control (note that the shape of the cursor changes 
when you are over the pane control), hold down the mouse button, and drag the 



control about half way up the summary window.  When you release the mouse 
button, the data table and the graph will be redrawn to fit in their new regions.  You 
can decrease the size of the table so that it is just barely visible or you can increase it 
so that several rows are displayed.  It is not possible to increase the table size past the 
point where a legible graph can be drawn.

When you use the pane control to create a larger data table, a scroll bar will appear 
on the right side if there are more rows of data than will fit in the table.  You can use 
this scroll bar to scroll through all of the data which were generated by this trial.  For 
this experiment there are three columns of data displayed in the table — time, E (the 
axon membrane potential), and iStim (stimulus intensity). The variable which is 
plotted on the x-axis (Time) is displayed on the far left of the table and is separated 
from the variables which are plotted on the y-axis (E and iStim) by a heavy black 
line.  In other problems, there might be more columns of data.  If there are more 
columns than will fit on the screen, a scroll bar will appear along the bottom of the 
table.  You can use the scroll bar to view all of the columns in the table.

Now take a look at the graph for this experiment.  Using the mouse, click on the 
graph somewhere along one of the data traces.  Two things will happen:  the data 
table will scroll so that the row which corresponds to this time step will be displayed 
at the top of the table; and the graph cursor  will move so that it is over the point on 
which you clicked.  The graph cursor is the long, dashed line which is drawn from 
the top to the bottom of the graph (see Figure 9).  You can also click on the graph 
cursor and drag it to different parts of the graph.  When you release the cursor, the 
data table will scroll to the row containing the data values for that time step.  This 
can be very useful when you want to know the exact value of a particular point on 
the graph.



Figure 9.
The Graph Cursor

Most of the graphs in an Axon experiment will have more than one data trace.  In 
our example, both Stimulus Intensity (iStim) and axon Membrane Potential (E) are 
plotted on the y-axis.  You can use the data table to help you identify a particular data 
trace.  In the table find the column labeled iStim.  This column contains the data 
which is plotted in the graph.  Using the mouse, place the cursor over the column 
heading, click the mouse and hold it down.  The data trace for these data will be 
plotted on the graph as a heavy dark line.  As soon as you release the mouse, the 
graph will be redrawn in its original form.  See Figure 10 for an example.  As you 
will see in Tutorial Problem # 2, this method of identifying data traces can be quite 
useful when there are several types of data being collected during an experiment.  If 
you click on the column heading for Time, a variable which cannot usefully be 
plotted on this graph, nothing will happen.



Figure 10.
Identifying data traces.  Holding the mouse button down in the title to a column of data will highlight 
that data (or plot that data) on the current graph.

Before we proceed, lets use the Notepad to take some notes on the simulation we 
have just run.  In the upper left hand corner of the summary window there is a 
small Notepad icon.  Clicking on this icon will open a Notepad window that you 
can use to record your observations about the experiment.  In Figure 11, the Notepad 
is open and some notes have been typed into it.



Figure 11.  
An open Notepad with notes typed in.

Before proceeding, let's take some notes on the simulation that has just been run.  
Click on the Notepad icon to open the notepad window and type in the following 
information:
Trial # 1

start = 0.5 msec
intensity = -100.0 µamp
duration = 0.1 msec

Click on the close box (upper left hand corner of the Notepad window) to close the 
window.  Notice that the Notepad icon has changed to indicate that the notepad is 
not empty.  For more information about using the Notepad see the section below on 
Communicating Your Results.

Running More Trials

Now we will run two more trials, each using a different stimulus pattern.  First, 
click on the experiment control button labelled New .  Notice that several things 
have changed.  The title of the current trial is now Trial 2 (displayed in the popup 
menu in the experiment control region).  The graph, while still visible, is now 
drawn in gray and the data table has been cleared.  The stimuli controls have 
reappeared and the stimulus is again drawn on the graph.  Finally, the Start button 



is now active and the label of the New button has changed to Reset.

Notice that the values of the stimuli controls and the position of the stimulus are 
the same as they were at the beginning of the first trial.  Until they are changed, each 
new trial will start with the same stimulus pattern (the default pattern).

Click on the black square handle on the lower right hand edge of the stimulus and 
drag it around.  (The handle on the x-axis changes the start time of the stimulus.  
We will leave this unchanged for now.)  Note that the stimulus pattern changes and 
that the relevant values in the stimulus control boxes (intensity and duration) show 
corresponding changes.  When you release the mouse button, the Reset button 
becomes active.  To recover the original stimulus pattern, click on the Reset button.  
Drag the stimulus handle so that you increase the size (intensity  and duration) of 
the stimulus.  Open the Notepad window and record the stimulus parameters for 
Trial #2.

Now click on the Start button to run Trial 2.  The data for this trial is plotted over 
the data for Trial 1.  Whenever your experiment involves running more than one 
trial, the data for the current trial will always be drawn with a black line and the data 
for any other trials will be drawn with gray lines.

When Trial 2 has stopped, click on the New Trial button to setup Trial 3 — only this 
time change the stimulus pattern by entering numbers directly from the keyboard.  
Click on the Start button to run Trial 3.  Your screen should now look something 
like Figure 12.  The exact shape of the curves will depend on the values which you 
chose for stimulus duration and intensity .



Figure 12.
Results of three runs with different stimulus intensities and durations.   Trial 3  is the current trial and 
is drawn in black.

Switching Between Trials

Our experiment has consisted of three trials, each with different values for stimulus 
intensity  and duration.  In Figure 12 (and on your computer screen) Trial 3 is the 
current trial.  This means that Trial 3 data is displayed in the table and drawn with 
dark lines on the graph.  Any operations on the data (such as copying or saving the 
data, discussed below) are always done on the data for the current trial.  As 
mentioned above, the title of the current trial is always displayed in the popup 
menu on the lower right of your screen (the Trial Menu).  You can also use this 
menu to make another trial the current trial.  When you click on the menu, you 
will see a list of all of the trials which have been run, with the current trial written 
in grey.  In order to switch to another trial, simply select the title of that trial and 
release the mouse.  Use the Trial  Menu to switch to Trial 1.  Notice that the graph 
has been redrawn so that the data for Trial 1 are drawn in black.  The data table has 
also been changed to display Trial 1 data.

Hiding a Trial

Sometimes when you are running an experiment with numerous trials the graph 



region can become very crowded and difficult to interpret.  The Visible Graphs 
popup menu, in the center of the screen above the graphs, allows you to hide the 
data traces for some trials.  When you click on the menu, you will see a list of all of 
the trials which have been run, with the current trial written in grey.  There will be 
a check mark next to all of the trials whose data traces are visible in the graph 
region.  

To hide the data traces for a trial with a visible graph (indicated by a check mark), 
simply select the title of that trial and release the mouse.  The graph region will be 
redrawn, hiding the data traces for that trial.  Selecting a trial which has no check 
mark will make that trial's graph visible.  Try hiding and redrawing the data traces 
for Trial 2.  

To hide or show all of the data traces (except the current trial) at once, click on Hide 
All Back or Show All Back.  It is not possible to hide the data traces for the current 
graph–the title of the current trial is inactive and written in grey to indicate this.  

The other graph controls at the top of the graph region will be discussed in the 
Reference section.

Drawing/Erasing a Data Trace

It is also possible to erase one or more of the data traces which are drawn for the 
current trial.  Pull down the Graph Menu in the menu bar at the top of the screen.  
All of the data items which are available for this problem will be listed, with check 
marks next to those which are drawn in the graph. (All of the data items in the list 
are always included in the data table.)  In Tutorial Problem # 1 two types of data are 
listed: Stimulus Current (iStim) and Membrane Potential (E).  Both are checked, 
indicating that both are drawn on the graph.  As in the Visible Graphs menu 
described above, the check mark can be toggled on and off by clicking on the item.  
Try toggling iStim on and off.  Notice that only the graph for the current trial is 
affected.

Scaling the y-Axis

The Graph Menu can also be used to change the scaling of the y-axis.  Pull down the 
Graph Menu and choose Set Graph Scales to display the Graph Scales window 
(Figure 13).  



Figure 13.
Graph Scales Window for Tutorial Problem #1

The Graph Scales window displays the maximum and minimum values for every 
type of data available in the current problem.  For Tutorial Problem #1, iStim and E 
are displayed; other problems may use different types of data.  Notice that iStim and 
E are measured in different units (E in mv and iStim in µamps) and that they have 
different scales — the scale for iStim goes from -200.00 µamps to +200.00 µamps 
while the scale for E goes from -100.00 mv to +100.00 mv.  This is typical for most of 
the data types available in Axon and is the reason the y-axis scales are not displayed 
on the graph.  You can use the Graph Scales window to change any or all of the data 
scales by selecting the appropriate box, typing in the values you want, and clicking 
the Apply  button.  To revert to the original scaling values, click the Default button.  
Close the Graph Scales window by clicking the close box in the upper left hand 
corner of the window.

Communicating Your Results

When you are finished running your experiment you are going to want to use the 
data which you have collected to make some observations about the problem which 
the experiment was designed to investigate.  You will probably want to make some 
notes about your experiment, look carefully at your data to see what it can tell you, 
and finally produce some sort of report which you can use to communicate your 
results to other people.  There are several tools in Axon which can help you do this.

Taking Notes

We have already used the Notepad to record the stimulus parameters for our 
experiment.  You can use the Notepad to record any observations that you think 
would be useful or relevant to your experiment. You can type into it, as we have 
already done, paste pictures into it, select parts of it to cut or copy into the clipboard, 
and print it.  You can also use Copy Window or Copy Graph (see below) to capture 
pictures from your screen and Paste to place them into the Notepad.  You cannot 
however save the Notepad.  Once you leave a problem, the information in the 
Notepad will be lost unless you have copied it to another program or printed it.  See 



the Reference section for more information on copying from the Notepad or 
printing the Notepad 

Taking Pictures

There are two tools in Axon which can be used to take pictures of your experiment.  
The Copy Window option under the Edit menu will put a picture of the current 
frontmost window on the clipboard.  The Copy Window Graph option, also under 
the Edit menu, will put a picture of just the data graph on the clipboard.  Once a 
picture is on the clipboard, it can be pasted into a Notepad or into another 
Macintosh program.  To paste into the Notepad, use the Notepad icon to open the 
Notepad window.  You may need to enlarge the window so that the entire picture 
will be visible.  With the text cursor positioned at a new line in the window, select 
Paste from the Edit menu.  The picture in the clipboard will be pasted into the 
Notepad.  For more information on using these tools, see the Reference section.

Exporting Data 

There are two ways you can export your data from Axon.  You can use the Copy 
Window Data option under the Edit menu to put a copy of all of the data in the data 
table onto the clipboard.  Once on the clipboard the data can be pasted into another 
program such as Excel™ or WingZ™ for further analysis.  Remember that the data 
table contains only the data for the current trial.  If your experiment has more than 
one trial, use the Trial menu to make each trial the current trial and copy its data 
onto the clipboard.  (Don't forget that the clipboard can only hold one item at a 
time.)

Because even a small experiment in Axon can generate a lot of data, copying and 
pasting can sometimes be quite time consuming.  It is often more convenient to use 
the Save Window Data option under the File menu to save your data.  This 
command will write all of the data in the current data table to a file.  This file can 
then be opened by another program, such as a word processor, and its contents used 
directly.  (This file contains only the data from the current trial in Axon, in the form 
of tab delimited text.  It cannot be opened by Axon or used to restore an Axon 
experiment.)

For more information on using the Notepad and exporting your data see the section 
on Communicating With Other Programs in the Reference section.

Leaving a Problem

When you have done everything you want to with a particular problem you can 
either start a new problem (select New Problem under the File menu) or quit Axon 
(select Quit under the File menu).  New Problem will return you to the Problem 



Selection window and Quit will exit the Axon program.  In either case you will first 
be reminded that leaving will destroy the problem and given the option of 
returning to save your data (see Exporting Data, above).  Figure 14 is a picture of this 
message box.

           

Figure 14
A message box which reminds you that leaving will destroy your problem.  Choose Cancel to return to 
your problem; New (or Quit) to continue.

There will always be a Cancel button, which will return you to the experiment.  The 
other button will be labeled either New or Quit, depending on which item you 
chose from the File menu.  If the button is labeled New, clicking on it will take you 
to the Problem Selection window;  if the button is labeled Quit, clicking will exit the 
Axon program.

Another Example - Demonstrating the Refractory Period

Before we leave Tutorial #1, let's look at another way you can use the Stimulus 
Well to investigate neurophysiology.  First use the New Problem command (under 
the File menu) to start a new problem.  Choose Tutorial #1 again.  Now you can use 
the Stimulus Well to add as many stimuli to your experiment as you like.  For 
instance, multiple stimuli can be used to demonstrate the refractory period.  Change 
the time scale on the x-axis to 20 msec (use the x-Axis Scale box).  The longer time 
scale allows more time to see the results of multiple stimuli.  Use the Stimulus 
Well to add another stimulus, positioning it at about 10 msec.  You now have two 
stimuli, one starting at 0.5 msec, the other at 10 msec.  You can use the Stimuli 
Controls described above to change the intensity  and duration of either of these 
stimuli.  Either drag the stimulus handle or click on the stimulus you want to 
change to make the numeric stimuli controls refer to that stimulus.  You can now 
run this experiment in the usual way.

Tutorial Problem #2 - Membrane Cartoon

Now that you know how to run a simple Axon experiment, Tutorial Problem #2 



will build on the information you learned in Tutorial #1 and introduce some 
additional ways to use the Axon program to investigate neuron physiology.  In this 
tutorial we will look at how the axon membrane cartoon can be used to study the 
events which take place during an action potential.  We will also look at some of the 
other kinds of data which can be generated during an Axon simulation.

Open the Axon application by double–clicking on the Axon icon or, if you already 
have another Axon problem open, use the New Problem command under the File 
menu to return to the Problem Selection window.  Start "Tutorial Problem #2 – 
Cartoon".  The Experiment Summary Window for this problem is very similar to 
the window for Tutorial # 1, except for the Membrane Cartoon towards the bottom 
of the window, and all of the techniques which you have already learned will be 
applicable here.

The Membrane Cartoon

Before we start, let's take a look at the Axon Membrane Cartoon.  The Membrane 
Cartoon  represents a cross-section of the cell wall of the axon, showing the outside 
of the cell, the inside of the cell, and the axon plasma membrane.  Figure 15 shows a 
picture of the Membrane Cartoon as it would look before a simulation is run.

Figure 15.
The Axon Membrane Cartoon before a simulation is run.

The thick black line represents the axon Plasma Membrane.  There is an arbitrary 
vertical line dividing the cartoon into two "windows"; the one on the left deals with 
sodium ions (Na+), the one on the right with potassium ions (K+).  No physical 
significance is attached to this division — it is simply a convenient way to represent 
the interaction of the two ions with the plasma membrane.  Notice the high Na 
concentration on the outside of the cell, poised to enter the cell, and the high K 
concentration on the inside of the cell, poised to exit.  The gray arrows represent the 
diffusion force — the tendency of the ion to diffuse across the membrane down its 



concentration gradient.  We will talk about the significance of the gray arrows later, 
when we use the membrane cartoon to examine the behavior of the Na and K ions 
during an action potential.

Now click on the Start  button and allow Trial #1 to run to completion.  Figure 16 
shows the Summary Window after the completion of Trial #1.

Figure 16.
Membrane cartoon after running one trial.  The arrows represent the forces acting on the Na and K ions.

Forces on the Na and K Ions

There are now two arrows associated with each ion.  The black arrow represents the 
electrical force acting on each ion, tending to move it across the membrane.  The 
gray arrow represent the diffusion force or the tendency of the ion to diffuse across 
the membrane down its concentration gradient.  In each case, an arrow pointing 
upwards denotes a force on the ion pushing it out of the cell.  A downward arrow 



pushes into the cell.  The net force on the ion is the algebraic sum of the two forces 
(arrows).

Now return to the graph for a moment.  Find the graph cursor .  (Remember that the 
graph cursor is the long vertical dashed line on the graph.  It marks a specific time in 
the experiment.  See Tutorial Problem #1 or the Reference section for more 
information.)  Click on the graph cursor and drag it back and forth across the graph.  
Notice that the arrows change in size and sometimes in direction as the graph 
cursor moves across the action potential.  The size and direction of the arrows 
reflects the electrical and diffusion forces on the ions at each instant indicated by the 
graph cursor.  Notice that the black (electrical) arrows change considerably, but the 
gray arrows remain constant.  This reflects the fact that the membrane potential is 
changing as the axon swings into action (in fact, the black arrow is simply another 
representation of the membrane potential (E) plotted in the graph) while the 
changes in concentration gradients which give rise to "diffusion forces" are 
imperceptible.  Recall that although Na enters and K leaves the cell during 
excitation, the actual amounts that enter or leave are insignificant when compared 
to the quantities of these ions on either side of the membrane.

Gates and Channels

There are two requirement for the net flow of an ion through a membrane:

1.  There has to be a net force in the direction of flow. 

2.  There has to be an open pathway (or channel) through the membrane.  

In this cartoon, open channels are represented by the gray lines extending across the 
membrane (see Figure 16, above).  Lines that do not extend across the membrane are 
closed channels.  To form a mental image of channel behavior, it is helpful to 
imagine that they are regulated by voltage activated gates which open or close in 
response to changes in membrane potential or voltage.  

Each K channel contains a single gate which blocks the K channel when it is closed.   
At any particular membrane potential (voltage), some of these gates are open and 
some are closed, but as the voltage becomes more positive, more of the gates will be 
open.  Figure 17 shows the potassium window, with some open K channels and 
some closed K channels.  



Figure 17.
Open and closed Potassium (K) Channels.

Unlike the K channels, each Na channels has two gates.  Both gates have to be open 
simultaneously for Na to pass through the channel.  Figure 18 shows the Na 
channels, both open and closed.

Figure 18.
Open and closed Sodium (Na) Channels. 

One of the two Na gates responds very quickly to any change in membrane 
potential.  It is called a fast Na gate and, when it is open, it is represented in the 
cartoon by a line starting at the outside surface of the plasma membrane and 
extending half–way through the membrane toward the inside surface.  Like K gates, 
Na fast gates tend to open as the voltage becomes more positive.   The other Na gate 
responds slowly to any change in membrane potential.  It is called a slow Na gate 
and, when it is open, it is represented in the cartoon by a line starting at the inside 
surface of the plasma membrane and extending half–way through the membrane 
toward the outside surface.  Thus, the channel is open only when both slow and fast 
Na gates are open simultaneously, shown in the cartoon by a line that extends the 
entire distance across the membrane.  (See Figure 18, above.)

The behavior of the axon is governed almost entirely by the precise timing of the Na 
and K gates as they open and/or close in response to changes in membrane potential 



(E).  The cartoon gives a visual picture of the position of these gates at any particular 
time (indicated by the position of the graph cursor) in the simulation.  The response 
of the Na and K gates to changes in membrane potential is shown in the following 
table (Figure 19).

Gates Speed of Response As E increases
(becomes more positive) As E decreases
(becomes more negative)
K Slow OpensCloses
Fast Na Fast OpensCloses
Slow Na Slow ClosesOpens

Figure 19.
Response of the Na and K gates to changes in membrane potential.

Move the graph cursor around and notice the effect on the Na and K gates and the 
electrical and diffusion forces on the ions.  As you try to interpret what you see, 
remember that:

1.  Changes in E reflect changes in net charge on the inner surface of the 
membrane.

2.  Increases in net charge are promoted primarily by positively charged Na ions 
moving into the cell and opposed by positively charged K ions moving out.

3.  Movements of Na or K ions are determined by the net force on the ion as well 
as the number of channels that are open to that ion.

4.  BOTH the fast AND the slow Na gates must be open in the same channel in 
order for the channel to be open.

Graphing Additional Variables

Now let's use the Graph menu to look at some of the other types of data which can 
be plotted on the graph.  In Tutorial Problem #1, there were only two types of data 
available — membrane potential (E) and stimulus current (iStim).  For this 
problem, we have added several more types of data.  Remember from Tutorial 
Problem #1 that you can control the data types which are plotted on the graph by 
selecting one of the data types listed in the graph menu.  If there is a check mark 
next to that item, it will be plotted on the graph; toggle the check mark off to erase 
those data from the graph.  Recall too that you can change the scale on any of the 
data items by choosing the Set Graph Scales item and entering the appropriate 
values in the graph scales table.  (See Tutorial Problem #1 or the Reference section 
for more information on using the Graph menu.)



Net Current, Na Ion Current, and K Ion Current 

Select Net Current (iNet) from the Graph menu.  Net Current is the net positive 
charge flowing through the membrane OUT of the cell.  (By convention, positive 
charge flowing INTO the cell is graphed in the downward direction; positive charge 
flowing OUT of the cell is graphed in the upward direction.)  When iNet is negative 
(positive charge flows into the cell), membrane potential (E) will increase; when it is 
positive, E will decrease (Figure 20).

Figure  20.
Graph of Net Current (iNet), Membrane Potential (E), and Stimulus Current (iStim).  When iNet is 
negative (positive charge flows into the cell), the membrane potential (E) increases; when iNet is 
positive, E decreases 

Verify this by moving the graph cursor to the point where iNet just crosses the zero 
line and changes from negative (positive charge flowing in ) to positive (positive 
charge flowing out).  At this point E has reached its maximum value — moments 
before it was increasing, moments later it will decrease.  (You can use the graph of 
iStim as a convenient marker for the zero line.)  If you use the pane control to 
enlarge the size of the data table, you can also see the exact values of E and iNet at 
each point where you release the graph cursor.

The value of iNet is determined almost entirely by the difference between K ions 



flowing out of the cell and Na ions flowing in.  You can demonstrate this by 
selecting Sodium Ion Current (iNa) and Potassium Ion Current(iK) from the Graph 
menu.  At the same time simplify the graph by erasing E from the graph.  You may 
also want to try the Rescale Control to see greater detail.  (Look under Graph 
Controls in the Reference section for more information about using the Rescale 
Control.)  Figure 21 shows a graph with these three traces plotted.

Figure 21.
Graph of Sodium Ion Current (iNa), Potassium Ion Current (iK), and Net Current (iNet).  The Stimulus 
Current trace serves as a zero current line.

The shapes and positions of these curves suggest that

iNet = iK + iNa.

In making this assessment, don't forget our conventions:  current OUT of the cell is 
positive, current INTO the cell is negative.  K is leaving the cell; therefore iK is 
positive.  Na is entering the cell; therefore iNa is negative.  When we add iK + iNa, 
we are adding a positive and a negative number (the same as taking the difference 
between K leaving and Na entering).

Ionic Currents Generated by an Excited Axon 
Dwarf the Stimulating Current.

It is instructive to compare the magnitude of the response (iNet, iK, and iNa) with 
the magnitude of the stimulus (iStim).  First we must adjust the graph scaling.  
Select Set Graph Scales from the Graph menu.  Notice that iNet, iK, and iNa all 
have the same scale (-1000 µamps minimum; 1000 µamps maximum) whereas 
iStim is plotted on a scale that is five times more sensitive (-200 µamps minimum; 
200 µamps maximum).  Change the scale to -1000 µamps minimum and 1000 µamps 
maximum, making it compatible with the other currents.  Click on the Apply button 
and close the scaling window by clicking on the close box in the upper right–hand 
corner.  It is now apparent that a relatively small current stimulus evokes an 
enormous response of membrane currents, emphasizing the explosive nature of the 
excitatory process (Figure 22).



Figure 22.
Comparison of the magnitude of the Ionic Currents (iNet, iK, and iNa) with the size of the Stimulating 
Current (iStim).

Potassium Conductance and Sodium Conductance

Now use the graph menu to switch off iNa, iK, and iNet and switch on Potassium 
Conductance (gK) and Sodium Conductance (gNa).  If Membrane Potential (E) has 
been switched off, turn it back on.  These conductances are proportional to the 
number of open channels — gNa for Na and gK for K.  Sometimes they are loosely 
referred to as the Na and K permeabilities.  Use the graph cursor to follow the 
conductance curves and notice the opening and closing of the corresponding gates 
in the membrane cartoon.  Remember that you can use the data table to help you 
identify a data trace — click on a column heading in the data table and those data 
will be temporarily drawn as a heavy line on the graph (see Tutorial #1 or the 
Reference section for more information).  This graph (Figure 23) is similar to typical 
textbook illustrations, but it is quantitative and available for study by accurately 
reflecting changes that accompany any changes in parameters.

Figure 23.
Graph showing changes in Na Conductance (gNa) and K Conductance (g) during excitation of the axon.

Tutorial Problem #3 - Voltage Clamps



Tutorial Problem #3 is not set up to stimulate the axon as in Tutorials #1 and #2.  
Instead, you will clamp the membrane voltage at a pre-determined level.  This 
simulates one of the most valuable experimental techniques in neurophysiology.  It 
gives the experimenter the opportunity to change the voltage and hold it at a set 
value - not letting it run away as it normally does when you stimulate it.  This is 
exactly what is required for a careful study of what happens on depolarization 
(stimulation) because you can choose the size of the depolarization and it will stay 
where you put it, while you monitor the flow of ions (current) through the 
membrane.

Open Tutorial Problem #3.  The screen is set to begin the clamp at 3 msec by 
"jumping" the membrane potential E from -65 to -20 mv, and to keep it at this value 
for 12 msec.  You can change the clamp parameters either by dragging or by inserting 
numerical values in the appropriate boxes, just as you did when stimulating the 
axon in  Tours #1 and #2.  We have arbitrarily removed the cartoon on this screen 
to provide space for the numerical tables.  (The same voltage clamp simulations 
could also be run with the cartoon in place of the table.)  Before starting the 
simulation we will simplify matters by wiping out the Na channels so that we deal 
only with K channels.  Do this by locating the gNaMax box and changing its value 
from 120 to 0.  Now start the simulation.  In the laboratory, the Na channels can be 
wiped out by applying a  Na channel blocker like tetrodotoxin or saxitoxin.

The flat step-like plot is the membrane voltage, E, which remains flat throughout 
the 12 msec interval between 3 and 15 msec. You can verify this:  click on E in the 
Table and see the trace of the flat curve thicken.  Click on gK in the table and the 
corresponding plot of gK, the K conductance, will display as long as you hold the 
mouse button down. The same holds for any of the quantities listed in the Table.  
Try some.  The other permanent plot is iNet, the net current.

Net Current

Net current (iNet) is very important.  To interpret it, note that gNaMax stands for 
the maximal Na flow possible through the membrane.  When gNaMax = 0, there is 
no possibility of any Na channel existing in an open state; in this case virtually all of 
the ion flow (net current) through the membrane (except for a very small amount of 
leakage) will be carried by K ions.  The experimenter is able to measure the net 
current flow through the membrane, and this is what is plotted in the simulation 
that has been set up.  By convention, a positive current represents positive ions 
flowing through the membrane out of the cell. Negative current represents positive 
ions flowing through the membrane into the cell.  Drag the graph cursor (dashed 
vertical line) to different places on the graph.  When you release the cursor, the table 
scrolls so that the top row corresponds to the position on the x-axis (Time) of the 
graph cursor.  The numbers in the top row of the table represent the values of 
variables at that time.  Note that the net current, iNet, is almost equal to iK, the K 
current  (they are both positive; K flows out of the cell).  The difference between 



them is the small leakage current carried by other ions.  Also note that the Na 
current, iNa ,as well as the Na conductance, gNa, are both equal to zero at all times; 
we have shut off the Na channels.

Measuring the Action of the Gates

The F_Na, S_Na, and S_K variables show the action of the gates.  (You may have to 
scroll the table to bring these variables into view.)  F_Na represents the fast Na 
gates.  It shows the % of these gates that are open at the time corresponding to the 
position of the graph cursor.  Similarly S_Na shows the % of open slow Na gates, 
and S_K shows the % of open K gates.  These variables give similar information, 
but in more precise numerical terms, as the cartoon.  The % of K channels that are 
open also equals S_K.  However, for a Na channel to open, both fast and slow Na 
gates have to be open simultaneously.  [The probability of a fast Na gate being open 
is given by  F-Na/100; while the probability of a slow Na gate being open is 
S_Na/100.  It follows that the probability of both events occurring simultaneously 
equals (F_Na/100) x (S_Na/100) and the percentage of open Na channels is simply 
100 x (F_Na/100) x (S_Na/100) 

Run a trial with the Na channels back on.  First start a new trial by clicking on the 
New button.  Turn the Na channels back on by setting gNaMax = 120.  Run the 
simulation by clicking on the Start button.  Look at the gates in the voltage clamp 
experiment as you scroll through it (the horizontal arrow keys on your keyboard 
will move the table (and the cursor) one time step at a time, or simply drag the 
graph cursor with the mouse).  Begin at t=0.  With no clamp turned on there are 
plenty of slow Na gates (S_Na) open but no fast ones (F_Na).  Now move forward 
in time.  As the clamp is turned on, the membrane depolarizes, fast gates open, and, 
for some time, the slow gates are also still open; Na can get through.  But, soon the 
slow gates close and Na can no longer pass. At the same time open K channels (S_K) 
begin to appear.  The membrane will stay in this state as long as the depolarization is 
maintained.

Estimating Na Ion Flow

The net current will show the charge flowing through the membrane.  Now it is 
carried by both Na and K ions (plus a small amount of "leakage" which we shall 
ignore).  The difference between the net current in Trial #1 with K channels only, 
and Trial #2 with both Na and K channels gives a good estimate of iNa, the Na ion 
flow through the membrane.  Remember it is iNet that is measurable.  Examine the 
iNet of Trial #2.  The dip in the curve is negative and it corresponds to Na entering 
the cell, while the later rise is due to K leaving.  The dip runs off scale.  To enlarge 
the scale, pull down the Graph menu from the top menu bar and select  Set Graph 
Scales.  A graph Scale window will open that will allow you to change the scale of 
any item that is or can be plotted with this particular setup.  Select iNet and change 



the scaling from -1000 < iNet < +1000 to -1200 < iNet < +1200.  Click on the Apply  
button to test the new scaling before closing the window  with the close box in the 
upper left hand corner.

Experiments with voltage clamps at several different voltage levels provided the 
data for our detailed interpretations of nerve excitation. These experiments are 
easily simulated with this program.  Look at the Appendix entitled Exercises 
(particularly Exercises #3A and Exercises #5A and #5B) for more ways to use a 
voltage clamp.

You can switch back from a voltage clamp experiment to the stimulation type that 
was carried out in Tours #1 and #2 by dragging the clamp icon (small box containing 
the letter "c") off the time  axis and dragging the stimulation icon (small black box) 
onto the time axis.  Try it.  Alternatively, both clamp and stimulating icons can be 
set on the axis.



Reference for Axon

Overview of Axon

Problem Selection Window

The Problem Selection window allows you to choose the environment within 
which you want to work.  A problem in Axon represents a micro-world within 
which you can formulate an hypothesis, design experiments to test your hypothesis, 
and organize and evaluate your data. Different problems will probably include 
different subsets of the experiment parameters available in Axon, allowing you to 
investigate different aspects of nerve physiology, or they may make different tools 
available for you to use. In addition, if editing has been enabled in your version of 
Axon, you can modify or delete an existing problem or create a new problem to fit 
your particular needs.

For more information on using the Problem Selection window read Tutorial 
Problem #1 (above) or Problem Editing (below).

Experiment Summary Window

Selecting a problem from the Problem Selection window and clicking on the start 
button will open an Experiment Summary Window  for that problem.  A Summary 
Window has several purposes:

• It displays the experiment parameters for the problem type selected and 
allows you to change their values.

• It allows several trials to be run using the same basic parameters in order to 
isolate the effects of changing a single parameter.

• It displays the results of the experiment in several different formats and 
provides tools for manipulating displays and exporting results.

There are many experiment parameters and tools which can be used in an Axon 
experiment.  Typically, no one Axon problem would need or want to use all of the 
experiment parameters and tools at one time.  The particular subset of parameters 
and tools which is available in a problem is determined when the problem is created 
using the Problem Editing facility (discussed below).



For the purposes of discussion, Figure 24 illustrates the Summary Window for a 
problem which was created with everything (except the membrane cartoon) enabled.  
The following sections will describe each of the elements of the summary window 
pictured here.  The membrane cartoon will be discussed in a later section.  Most of 
these elements are also described in either Tutorial Problem #1 or Tutorial Problem 
#2.

Figure 24.
An Experiment Summary Window with everything enabled, except the Membrane Cartoon.

When an Axon problem is first opened, the Summary Window will be the 
frontmost , or active,  window (indicated by the horizontal lines drawn in the title 
bar at the top of the window).  Most operations in Axon will require that the 
Summary Window be the active window.  If the Summary Window is not the 
currently active window (for instance, if the Notepad is open and active), clicking 
anywhere in the window will make the Summary Window active again.



Graph Controls

Several tools are provided for manipulating the Summary Window graphs. In 
addition to the Graph menu  (discussed below) which allows you to select the types 
of data to plot, the Graph Controls can be used to display the graphs in different 
ways. The Graph Controls appear in the area above the graph, see Figure 25.

Figure 25.
Graph controls displayed above the graph in the Summary Window.

  The Visible Graphs popup menu allows you to hide the data 
traces for some trials.  When you click on the menu, you will see a list of all of the 
trials which have been run, with the current trial written in grey.  There will be a 
check mark next to all of the trials whose data traces are visible in the graph region.  

To hide the data traces for a trial with a visible graph (indicated by a check mark) 
simply select the title of that trial and release the mouse.  The graph region will be 
redrawn, hiding the data traces for that trial.  Selecting a trial which has no check 
mark will make that trial's graph visible.  The title of the current trial is written in 
grey to indicate that the data for the current trial can never be hidden. 

   Click on the Grid Control to draw (or remove) a grid on the graph.

  Click the mouse on the Rescale Control (the magnifying glass). Now click inside 
the graph and drag the mouse to draw a dotted rectangle over a portion of the data 
in the graph.  When you release the mouse, the data inside the rectangle will be 
rescaled to fit the graph area, "zooming in" the outlined data (Figure 26). 



Figure 26.
Use the Rescale tool to mark a new region for plotting. The Zoom box will restore the original scaling.

  Click on the Zoom Box to switch between the most recent rescale and normal 
graph scaling settings.

X-Axis Scale

The scale for the x-axis (Time) is displayed in the X-Axis Scale Control on the far 
right, underneath the horizontal axis of the graph.  The scale can be changed by 
entering a new value in the box.  The scale can only be change at the beginning of a 



trial — it is not possible to stop a trial before it is finished, changed the scale, and 
then continue the trial with the new scale.  If the scale is changed when a new trial 
is created, the data for all of the previous trials will be rescaled to the new x-axis 
scale.  Thus all trials in an experiment are always plotted using the same time scale.

Stimuli Controls

Axon allows you to set up experiments using two different types of stimuli:  square 
wave stimuli and ramp stimuli.  Stimuli are plotted on the graph as intensity of 
stimulating current (iStim) versus Time.  The intensity of the stimulus is measured 
along the y-axis and the duration along the x-axis.  A square wave stimulus has a 
rectangular shape, indicating that the stimulus intensity is constant; a ramp 
stimulus is triangular in shape, with stimulus intensity starting at zero and 
increasing or decreasing linearly throughout its duration.  The stimuli are drawn on 
the graph as a solid line with a small box, or "handle", on the right–hand side.  
Using the tools in the Stimuli/Clamp Controls area you can add additional stimuli 
to your experiment and change the characteristics (starting time, intensity , and 
duration) of the stimuli.  These tools are shown in Figure 27, below.

Figure 27.
Stimuli/Clamp Controls including the Stimulus Well, the Clamp Well, and the Numeric 
Stimuli/Clamp Controls.

Adding Stimuli

The tool for adding stimuli to your experiment is the Stimulus Well.  This tool 
works in much the same way as the "tab well" found in many word processing 
programs — if you want to add a tab to your document, you click on the tab symbol 
and drag it into the correct position on a formatting ruler.  Similarly, if you want to 



add a stimulus to your Axon experiment, you click on one of the small symbols in 
the Stimulus Well and drag the stimulus into position on the x-axis of the graph.  
The square symbol will add a square wave stimulus; the triangular one will add a 
ramp stimulus.  The point at which you release the stimulus will be its starting 
point, marked by the stimulus symbol on the x-axis and by a vertical dotted line in 
the graph.

Modifying Stimuli

You can change the intensity and the duration of a stimulus by clicking on the 
"handle" and dragging the outline of the stimulus to a new position.  Moving the 
handle along the Time axis (x-axis) will change the duration; moving the handle 
along the y-axis will change the intensity.  You can also change the start time of a 
stimulus by clicking on the symbol on the x-axis and dragging it to a new position.  
To remove a stimulus from the graph, click on the symbol and drag it down off the 
graph until it disappears.  If your problem has the Numeric Controls enabled, the 
start, intensity, and duration of the stimulus are also displayed numerically in the 
boxes in the Stimuli Controls area underneath the graph.  (See the section on 
Problem Editing for information on enabling tools.) The intensity , duration, and 
starting point of the stimuli can also be changed by editing the values in these boxes.

   The controls for adding and modifying stimuli are only available at the beginning 
of a new trial — it is not possible to modify stimuli during a trial.

An Example

You can add as many stimuli to your experiment as you like.  For instance, multiple 
stimuli can be used to demonstrate the refractory period. To set up this experiment, 
start Axon using Tutorial Problem #1.  Change the time scale on the x-axis to 20 
msec (use the x-Axis Scale box).  The longer time scale allows more time to see the 
results of multiple stimuli.  Use the Stimulus Well to add another stimulus, 
positioning it at about 10 msec.  You now have two stimuli, one starting at 0.5 msec, 
the other at 10 msec.  You can use the Stimuli Controls described above to change 
the intensity and duration of either of these stimuli.  Either drag the stimulus 
handle or click on the stimulus you want to change to make the numeric stimuli 
controls refer to that stimulus.  You can now run this experiment in the usual way.  
(For more information on running an experiment see Tutorial Problem #1 or the 
section below on Experiment Controls.)

Clamp Controls

Adding Clamps

If voltage clamps have been enabled in your problem (see the section on Problem 



Editing for information on enabling tools), Axon will also allow you to add voltage 
clamps to your experiments.  Clamps are plotted on the graph as Voltage versus 
Time.  Like stimuli, the intensity of the clamp is measured along the y-axis and the 
duration along the x-axis.  Clamps are plotted on the graph as a solid, straight line 
with a small box, or handle, on both ends.  Like stimuli, you can add clamps to your 
experiment by dragging the small "c" symbol from the Clamp Well onto the x-axis 
(see Figure 27 above).  The point at which you release the clamp symbol will be its 
starting point, marked by the "c" symbol on the x-axis and by a vertical dotted line in 
the graph.

Modifying Clamps

The parameters of clamps can be modified using the same techniques used for 
modifying stimuli.  The intensity and the duration of a clamp are changed by 
clicking on either of the clamp handles and dragging to a new position.  Clicking on 
the left–hand handle will also change the start time.  You can also change the start 
time of a clamp by clicking on the symbol on the x-axis and dragging it to a new 
position.  To remove a clamp from the graph, click on the "c" symbol and drag it 
down off the graph until it disappears.  If your problem has the Numeric Controls 
enabled, the start, amplitude, and duration of the clamps can also be changed by 
typing values directly into the boxes in the Controls area underneath the graph.

The controls for adding and modifying clamps are only available at the beginning of 
a new trial — it is not possible to modify clamps during a trial.

Control Panel

There are several other parameters in the Axon model which can be controlled by 
the experimenter:  maximum sodium conductance (gNaMax), maximum potassium 
conductance (gKMax), ion leakage.conductance (gLeak), and capacitance (C).  (See the 
section on Problem Editing for information on enabling parameters.)   If any of these 
parameters are enabled, a control for that parameter will appear in a Control Panel 
directly above the experiment controls at the bottom of the window (Figure 28).

Figure 28.



The Parameter Control Panel

Values for the parameters can be entered directly into the text box next to the 
parameter name.  Once the value of a parameter has been changed, all subsequent 
trials in this experiment will be initialized to the new value.   These controls are 
only available at the beginning of a new trial — it is not possible to modify 
parameters during a trial.

Data Table

The Data Table contains all of the data generated from the current trial of an Axon 
experiment.  Each row of the table represents a timestep in the experiment (see 
Problem Editing for information on changing the size of the timestep).  The variable 
which is plotted on the x-axis (Time) is displayed on the far left of the table and is 
separated from the variables which are plotted on the y-axis by a heavy black line.  
There is a column for each of the graphable variables (see the section on the Graph 
Menu for an explanation of the graphable variables), whether or not those data are 
currently plotted in the graph.  If the data for a variable are plotted in the graph, the 
column heading for that variable is written in bold letters.  If there are more 
columns or rows of data than will fit on the screen, scroll bars will be drawn along 
the right–hand side or bottom of the table.  You may need to use the pane control 
(see below) to enlarge the table if it is too small to display the vertical (right–hand)  
scroll bar

Pane Control

In most of the Axon problems which include the data table, the table will probably 
initially be very small, often no more than one row.  It is possible, however, to 
change the size of the table using the Pane Control.  The Pane Control is the small, 
black rectangle on the upper, right hand corner of the data table (see Figure 29).  

Figure 29.
The Pane Control



Move the cursor over the pane control (note that the shape of the cursor changes 
when you are over the pane control), hold down the mouse button, and drag the 
control about half way up the summary window.  When the mouse button is 
released, the data table and the graph will be redrawn to fit in their new regions.  
The size of the table can be decreased so that it is just barely visible or increased it so 
that several rows are displayed.  It is not possible to increase the table size past the 
point where a legible graph can be drawn.

Scrolling the Table

The table in a summary window can hold considerably more information than it 
has room to display, even if the pane control is dragged to give the table as much 
room as possible.  Scroll Bars allow the user to see the parts of the table that are not 
immediately visible.  Every scroll bar is either active or inactive.  An active scroll bar 
has a gray background, which indicates that there is invisible material.  An inactive 
scroll bar is all white, indicating that all available material is already visible.  The 
vertical (right–hand) scroll bar may not be drawn if the data table is too small to 
display it.  Use the pane control to make the table larger and the scroll bar will 
appear.

The table can be scrolled to a particular time in the experiment either by using the 
vertical scrollbar or by clicking on the graph.  Clicking on the graph will scroll the 
table so that the data for that timestep are displayed at the top of the table.  There is 
also a Graph Cursor which can be used to scroll the table.  The graph cursor is the 
long, dashed line which is drawn from the top to the bottom of the graph (see Figure 
30, below).  Click on the cursor and move it to a spot on the graph.  When the cursor 
is released, the table will scroll to that timestep.

Figure 30.
The Graph Cursor



Identifying Data Traces

You can also use the data table to help you identify a particular data trace.  Using the 
mouse, place the cursor over the column heading, click the mouse and hold it 
down.  The data trace for these data will be plotted on the graph as a heavy dark line.  
As soon as you release the mouse, the graph will be redrawn in its original form.  
See Figure 31 below for an example.

Figure 31. 
Identifying data traces.  Holding the mouse button down in the title to a column of data will highlight 
those data on the current graph.

If you click on the column heading for a variable which cannot usefully be plotted 
on this graph (such as the variable plotted on the x-axis), nothing will happen.

Experiment Controls

The Experiment Controls are used to start, stop, or continue an experiment trial; to 
start a new experiment trial; and to switch back and forth between trials which have 
already been run.   The Experiment Controls are drawn in a panel at the bottom of 
the summary window (see Figure 24, above).

The two buttons on the right–hand side of the experiment controls panel (the 



Start/Stop/Continue button and the New/Reset button) are used to control the 
experiment trials.  At the beginning of a trial, the buttons will be labelled Start and 
Reset.  Clicking on the Start button will start the trial and the label in the Start 
button will change to Stop.   Clicking on the Stop button will stop the trial at that 
point.  If the trial is stopped before it has run for the maximum time set on the x-
axis, the label in the Start button will change to Continue.  Clicking on the Continue 
button will resume the trial where it was stopped. If the trial is allowed to run for 
the maximum time set on the x-axis, the trial will automatically stop and the label 
on the button will change back to Start.   However, the button will be inactive (grey) 
because the trial has already been run for the maximum time.

The New/Reset button has two functions.   At the beginning of a trial, before the 
Start button has been clicked,  it is possible to change the value or position of some 
of  the experiment parameters.  If you change your mind about these changes, 
clicking on the Reset button will reset all of the parameters to the values/positions 
they had at the beginning of the experiment.  The Reset button will be inactive 
(grey) unless a change is made to one of the experiment parameters.   Once a trial 
has been started and stopped, even if it has not run for the maximum time, the 
Reset button will change to the New button.  Clicking on the New button will set up 
a new experiment trial.   The parameter controls, which disappear while a trial is 
being run, will reappear, the data table will be cleared, and the data for the previous 
trial will be drawn on the graph in grey.

The Trial Menu is the popup menu on the left–hand side of the Experiment 
Controls.  In Axon, although it is possible to have several trials in an experiment, 
only one trial can be the current, or active, trial.  The current trial is the trial whose 
data are "active" — that is, these are the data which are displayed in the data table 
and drawn in black on the graph, in "front" of any other data, which are drawn in 
grey.  Any operations on the data, such as modifying the graphs, copying graphs or 
data (discussed below), or changing parameters, are always done on the current trial.  
You can tell which trial is the current trial by checking the Trial Menu — the title of 
the current trial is always displayed here.  You can also use this menu to make 
another trial the current trial.  When you click on the menu, you will see a list of all 
of the trials which have been run, with the current trial written in grey.  In order to 
switch to another trial, simply select the title of that trial and release the mouse. 

The Membrane Cartoon

The Membrane Cartoon represents a cross-section of the cell wall of the axon, 
showing the outside of the cell, the inside of the cell, and the axon plasma 
membrane.  Figure 32 shows a picture of the Membrane Cartoon as it would look 
before a simulation is run.



Figure 32.
The Axon Membrane Cartoon before a simulation is run.

The thick black line represents the axon Plasma Membrane.  There is an arbitrary 
vertical line dividing the cartoon into two "windows"; the one on the left deals with 
sodium ions (Na+), the one on the right with potassium ions (K+).  No physical 
significance is attached to this division — it is simply a convenient way to represent 
the interaction of the two ions with the plasma membrane.  (Some problems may 
only have one of the "windows".)  Notice the high Na concentration on the outside 
of the cell, poised to enter the cell, and the high K concentration on the inside of the 
cell, poised to exit.

Figure 33 shows the Summary Window after the completion of a trial.



Figure 33.
Membrane cartoon after running one trial.  The arrows represent the forces acting on the Na and K ions.

Forces on the Na and K Ions

After a trial has been run there are two arrows associated with each ion.  The black 
arrow represents the electrical force acting on each ion, tending to move it across the 
membrane.  The gray arrow represent the diffusion force or the tendency of the ion 
to diffuse across the membrane down its concentration gradient.  In each case, an 
arrow pointing upwards denotes a force on the ion pushing it out of the cell.  A 
downward arrow pushes into the cell.  The net force on the ion is the algebraic sum 
of the two forces (arrows).

Clicking on the graph cursor and dragging it back and forth across the graph will 
animate the membrane cartoon.  The arrows representing the ionic forces will 
change in size and sometimes in direction as the graph cursor is moved across the 
action potential.  The size and direction of the arrows reflects the electrical and 
diffusion forces on the ions at each instant indicated by the graph cursor.  The black 



(electrical) arrows will change considerably, but the gray arrows will remain almost 
constant.  The reflects the fact that the membrane potential is changing as the axon 
swings into action (in fact, the black arrow is simply another representation of the 
membrane potential (E) plotted in the graph) while the changes in concentration 
gradients which give rise to "diffusion forces" are imperceptible.

Gates and Channels

There are two requirement for the net flow of an ion through a membrane:

1.  There has to be a net force in the direction of flow. 

2.  There has to be an open pathway (or channel) through the membrane.  

In this cartoon, open channels are represented by the gray lines extending across the 
membrane (see Figure 33, above).  Lines that do not extend across the membrane are 
closed channels.  To form a mental image of channel behavior, it is helpful to 
imagine that they are regulated by voltage activated gates which open or close in 
response to changes in membrane potential or voltage.  

Each K channel contains a single gate which blocks the K channel when it is closed.   
At any particular membrane potential (voltage), some of these gates are open and 
some are closed, but as the voltage becomes more positive, more of the gates will be 
open.  Figure 34 shows the potassium window, with some open K channels and 
some closed K channels.  

Figure 34.
Open and closed Potassium (K) Channels.

Unlike the K channels, each Na channels has two gates.  Both gates have to be open 
simultaneously for Na to pass through the channel.  Figure 35 shows the Na 
channels, both open and closed.



Figure 35.
Open and closed Sodium (Na) Channels. 

One of the two Na gates responds very quickly to any change in membrane 
potential.  It is called a fast Na gate and, when it is open, it is represented in the 
cartoon by a line starting at the outside surface of the plasma membrane and 
extending half–way through the membrane toward the inside surface.  Like K gates, 
Na fast gates tend to open as the voltage becomes more positive.   The other Na gate 
responds slowly to any change in membrane potential.  It is called a slow Na gate 
and, when it is open, it is represented in the cartoon by a line starting at the inside 
surface of the plasma membrane and extending half–way through the membrane 
toward the outside surface.  Thus, the channel is open only when both slow and fast 
Na gates are open simultaneously, shown in the cartoon by a line that extends the 
entire distance across the membrane.  (See Figure 35, above.)

The behavior of the axon is governed almost entirely by the precise timing of the Na 
and K gates as they open and/or close in response to changes in membrane potential 
(E).  The cartoon gives a visual picture of the position of these gates at any particular 
time (indicated by the position of the graph cursor) in the simulation.  The response 
of the Na and K gates to changes in membrane potential is shown in the following 
table (Figure 36).

Gates Speed of Response As E increases
(becomes more positive) As E decreases
(becomes more negative)
K Slow OpensCloses
Fast Na Fast OpensCloses
Slow Na Slow ClosesOpens

Figure 35.
Response of the Na and K gates to changes in membrane potential.

Move the graph cursor around and notice the effect on the Na and K gates and the 
electrical and diffusion forces on the ions.  As you try to interpret what you see, 
remember that:



1.  Changes in E reflect changes in net charge on the inner surface of the 
membrane.

2.  Increases in net charge are promoted primarily by positively charged Na ions 
moving into the cell and opposed by positively charged K ions moving out.

3.  Movements of Na or K ions are determined by the net force on the ion as well 
as the number of channels that are open to that ion.

4.  BOTH the fast AND the slow Na gates must be open in the same channel in 
order for the channel to be open.

For more information on using the membrane cartoon, see Tutorial Problem #2, 
above.

The Axon Menus

The Apple Menu is a standard menu which is usually present in every Macintosh 
application.  Most of the items in this menu will depend on the particular setup of 
your Macintosh — what Desk Accessories you have, what version of the System you 
are running, etc.. At the top of the menu, however, are two items which are specific 
to Axon.  

About Axon ...  This item will display a window which gives you some 
information about the people and organizations responsible for the Axon program.  
You can also find the current version number of your program by checking here.  

Help With Axon...This item gives you access to the Axon Help system.  
Clicking on this item will display a window which provides you with help on a 
variety of topics.  The Axon Help system is discussed in greater detail in the Getting 
Help section below.

The File Menu contains several items which help you to manage Axon problems 
and data.

New Problem...   Choose the New Problem item when you are finished 
working with the current problem and want to start (or edit) a new problem.  
Clicking on this item will return you to the Problem Selection window, first putting 
up a message box which reminds you that leaving will destroy the current problem.   
You will be given the option of returning to save your data (click on the Cancel 
button) or continuing (click on the New button).   If you choose to continue, any 
information on your problem which you have not already saved by printing the 
Notepad, writing your data to a file, or exporting pictures or data to another program 
(see Communicating With Other Programs, below) will be lost.  Figure 37 is a 
picture of this message box.



Figure 37.  
A message box which reminds you that leaving will destroy your problem.  Choose Cancel to return to 
your problem; New (or Quit) to continue.

Save Window Data...  The Save Window Data menu item opens a dialog box 
which allows you to write all of the data in the current data table to a file.  This file 
can then be opened by another program, such as a word processor, and its contents 
used directly.  (This file contains only the data from the current trial in Axon, in the 
form of tab delimited text.  It cannot be opened by Axon or used to restore an Axon 
experiment.)  For more information on using Save Window Data see the section 
below on Communicating With Other Programs.

Page Setup...  This is the standard Macintosh command which sets up a 
document for printing.

Print Notepad   Choose this command when you want to print the contents of 
your Notepad.  You must first make certain that the Notepad window is open and is 
the active, or frontmost, window.  See the section in Communicating With Other 
Programs on Printing Notepads for more information.

Quit   Choose the Quit item when you are finished working with Axon and 
want to exit the program.  You will first be reminded that quitting will destroy the 
current problem (see Figure 37 above) and given the option of returning to save 
your data or quitting.  If you choose the quit, any information on your problem 
which you have not already saved by printing the Notepad, writing your data to a 
file, or exporting pictures or data to another program (see Communicating With 
Other Programs, below) will be lost.

The Edit Menu contains the standard Macintosh editing options (Undo, Cut, Copy, 
Paste, and Clear) as well as three Axon specific items:   Copy Window,  Copy Window 
Graph, and  Copy Window Data.  These three items can be used to create pictures of 
the entire Axon Experiment Summary Window, or just the graph, or just the data 
for the current trial of the Axon experiment.  These pictures can then be pasted into 
the Axon Notepad or into another program such as a wordprocessing program or a 
spreadsheet program.  These functions are discussed in greater detail in the section 
titled Communicating With Other Program below.



The Graph Menu controls the data which will be plotted on the graph.  

 The Data Types.   At the top of the menu there is a list of the types of data 
which are available for graphing in this Axon problem.  (See the section on Problem 
Editing for information on making data types available for graphing.)  Depending 
on the setup of the problem you are working with, there can be as many as eleven 
types of data listed.  Figure 38 shows the graph menu with all of the possible data 
types displayed.  

Figure 38.  
The Graph Menu 

If an item is checked, it will be displayed in the graph.  Unchecking an item will 
remove it from the graph.

 Graph All   and  Graph None    These items can be used to turn graphing on or 
off for all of the items at once.

 Set Graph Scales ...  This item is used to set the y-axis scale of the data types 
available in this problem.  Clicking on Set Graph Scales will display the Graph Scales 
window (Figure 39).  



Figure 39.  
The Graph Scales Window 

The Graph Scales window displays the maximum and minimum values for every 
type of data available in the current problem, whether or not it is current plotted on 
the graph.  Notice that most of the data types are measured in different units and 
that they have different scales.  This is the reason the y-axis scales are not displayed 
on the graph.  You can use the Graph Scales window to change any or all of the data 
scales by selecting the appropriate box, typing in the values you want, and clicking 
the Apply button.  To revert to the original scaling values, click the Default  button.  
Close the Graph Scales window by clicking the close box in the upper left hand 
corner of the window.

Setting Parameters

The experiment parameters can be changed at the beginning of every new trial in an 
Axon experiment.  Once a trial has been started, it is no longer possible to change the 
parameters until a new trial has been created using the New button.  A new trial 
will usually be starting using the parameters which were set for the previous trial.  
Stimuli and clamp controls are an exception — these always revert back to the 
initial default setting for new trials.  It is always a good idea to make notes on any 
changes in the stimuli parameters (use the Notepad, discussed below), since the 
values are not recorded elsewhere.  For information on setting specific experiment 
parameters, see the sections on Experiment Controls, Stimuli, Clamps, and X-Axis 
Scaling.

Getting Help

There are several ways to ask for help from Axon or any other BioQUEST program.

Why Can't I Use This Menu Item?



At any one time several menu items will be gray, indicating that they are inactive 
and therefore cannot be used.  Active menu items appear in black.  It is not always 
obvious why a menu item is inactive, or how to make it active.  In Axon, if you try 
to choose an inactive menu item, you will get a short message explaining what to do 
in order to enable it (see Figure 40).  Usually this means selecting an object.

Figure 40. 
A Help message explaining why the Print Notepad menu item is inactive.

Use the scroll bar on the right to see text that is not immediately visible.  When you 
have finished reading the help message, you can dismiss it by clicking in the 
window close box.

What Is This Thing For?

To find out what something is or does, you need to be in Help Mode.   To enter help 
mode, press the command key () while simultaneously pressing the question mark 
(?) key.  On some keyboards there is a key labeled help .  If your keyboard has a help 
key, it will do the same thing.

When you are in help mode, the mouse cursor will look like this , instead of the 
usual arrow shape.  In help mode, all menu items are always active.  Selecting a 
menu item will give you a short description of what the menu item does (see Figure 
41).



 

Figure 41
An Explanation of the File:Save Window Data menu item

Besides menus,  you can click on just about anything and get some information 
about it.  

Usually, you automatically drop out of help mode after you get help once.  
Sometimes you want to ask for help on several things and it is useful to stay in help 
mode.  If you hold down the option  key while clicking, you will stay in help mode.

What About the Big Picture?

The general help system is accessible from the Help With Axon  option under the 
Apple ( ) menu.  If you choose this option you will be given a list of topics from 
which to choose the subject of interest (see Figure 42).  To open a topic, click on it 
and click the Open  button at the bottom of the help window, or double click on the 
topic line.  When you open a topic you will see a discussion of the subject.  At the 
bottom of the window there will be a Back  button.  Pressing it will return you to the 
topic list.



 

Figure 42
The Help With Axon  topic list.  Clicking Open will lead to information about "An Overview of the 
Summary Window".

Communicating With Other Programs

Using Notepads

Every problem has an associated notepad;  to open it, click on the notepad icon (  or 

) in the upper right corner of the experiment summary window.   The notepad 
stays in existence as long as you do not destroy its associated problem.  You can close 
it temporarily by clicking in its close box, and when you re-open it, any notes you 
typed will still be there.

A blank notepad icon indicates that the corresponding notepad is currently empty.

Use the notepad just as you would any other Macintosh word processor.  You can 
type into it, paste pictures into it, select parts of it to cut or copy into the clipboard, 
and print it.  

Unfortunately, however, it is not possible to copy and paste mixed text and pictures 
at one time.  To copy a notepad that contains both text and pictures you need to do 
the following:

• Select the entire contents of the notepad.  You can do this by clicking before the 
first word and dragging to the end, or by clicking once before the first word, 
scrolling to the end, and shift-clicking after the last character.



• Choose Copy  from the Edit menu.

• Paste the result into an external word processor.  Where pictures exist in the 
original notepad you will see a little box ( ).

• For each picture in the notepad:

• Select the picture.  It is critical that you select only the picture and no 
surrounding blank space.  Watch out for returns after a picture.

• Choose Copy  to put a copy of the picture on the clipboard.

• Paste the picture into your word processor.

If you are not familiar with standard Macintosh word processing methods you 
should consult your Macintosh Owner's Guide for a description.

Printing Notepads

To print a notepad, make sure that it is the frontmost window (clicking somewhere 
in the window will make it frontmost).  The frontmost window is the only window 
which has a set of parallel horizontal lines around its title.  Then choose Print 
Notepad from the Edit menu.

Using The Clipboard

Most communication between Axon and other programs takes place via the 
Macintosh Clipboard.  Think of the clipboard as a place you can temporarily store a 
piece of text or a picture from one program, and then retrieve it from another 
program.  You proceed by copying material (use the Copy  command in the Edit 
menu) from one program into the clipboard, switching to the other program, and 
then pasting (use the Paste  command) the clipboard into the second program.

It can be quite clumsy to move several different things between the same two 
programs, since the clipboard can only hold one thing at a time.  In this situation 
you may want to look into using the Macintosh Scrapbook (see your Macintosh 
Owner's Guide) which can hold more than one thing at a time.

Copy Window

The Copy Window option on the Edit menu is active as long as there is at least one 



Axon window open.  It will put a picture of the current frontmost window on the 
clipboard.  Once it is on the clipboard it can be pasted into a notepad or into another 
Macintosh program.

The picture of the window looks exactly like the window.  This is potentially 
confusing because it is not a window any more, but just a picture of one.  This 
means that the close box and other controls will not work.

Copy Window Data

The Copy Window Data  option on the Edit menu will put a copy of the data 
displayed in the data table of the experiment summary window on the clipboard in a 
form that is usable (not just displayable) by other programs.  The data table contains 
only the data for the current trial.  If your experiment has more than one trial, use 
the Trial Menu to make each trial the current trial and copy its data onto the 
clipboard.  (Don't forget that the clipboard can only hold one item at a time.)

The data is in tab delimited text  format, a format that is usable by many word 
processors, spreadsheets, data base managers, and graphing programs.  Tab delimited 
text is text arranged in columns with each column separated by a tab.  If you paste 
this into a word processor you will need to set the tab stops to line up the columns.

Copy Window Graph

The Copy Window Graph option on the Edit menu will put a copy of the graph in an 
Experiment Summary window on the clipboard.  This option is only available if the 
frontmost window is an Experiment Summary window.

Save Window Data

Because even a small experiment in Axon can generate a lot of data, copying and 
pasting can sometimes be quite time consuming.  It is often more convenient to use 
the Save Window Data option, under the File menu, to save your data.  This 
command opens a standard Macintosh Save File dialog which allows you to create 
and name a file.  All of the data for the current trial will be written to this file and 
stored on the disk.  The data is in tab delimited text format that is usable by many 
word processors, spreadsheets, data base managers, and graphing programs.  Since 
this data file is separate from the Axon program, your data will be available even 
after you have started another problem or quit the Axon program.

Note:  This file will contain only the data from the current trial in Axon.  To save 
the data from other trials, use the Trial popup menu to make each trial the current 



trial and then use Save Window Data to save that trial's data to a separate file.  Also, 
do not confuse this command with the Save Problem command available in some 
other BioQUEST applications.  This file contains only the data from a single trial.  It 
cannot be opened by Axon or used to restore an Axon experiment.

Manipulating Windows

Selecting a Window

In Axon, as in most Macintosh programs, there can only be one Active Window at 
any time.  This is important because many operations can only be done to the active 
window.  For instance, the notepad cannot be printed unless it is the active window; 
the graph in the summary window cannot be copied unless the summary window is 
the active window.  The active window is the window that has the set of horizontal 
lines at the top, around the window title.  If the window has a close box (summary 
windows don't), then the close box is only visible when the window is active.  Any 
window can be made the active window by clicking anywhere within the window.

Closing a Window

The only way to close an Experiment Summary window is to choose either New 
Problem  or Quit in the File menu.  Since an Experiment Summary window 
essentially is an Axon problem, it is opened and closed by opening or closing a 
problem.  Leaving an Axon problem (closing the window) will irretrievably destroy 
everything contained in the summary window, as well as any notes contained in 
the notepad attached to that summary window.  Be sure you have copied any data, 
pictures, or notes that you want to keep before you leave a problem.

The other Axon windows (the help windows, the notepad window, or the graph 
scales window) can be closed by clicking in the Close Box,  found in the upper left 
corner of the title bar.

Moving a Window

Clicking anywhere on the titlebar (the title of the window or the horizontal lines to 
either side of it, but not in the close or zoom boxes) will cause a grey box to be drawn 
around the outline of the window. While the mouse is held down this outline may 
be dragged around the screen, and when the button is released the window will be 
redrawn where its outline was dragged to.



Zooming a Window

Some of the Axon window will have a Zoom Box in the upper, right–hand corner 
of the title bar.   Clicking in the Zoom Box will enlarge the window.  Clicking in the 
same place again will shrink it back to its former size and position.

Resizing a Window

To change the size or shape of a window, click the mouse on the Grow Box  (lower 
right corner) and, while holding the mouse button down, drag the mouse.  Drag the 
mouse down to make the window taller and to the right to make the window wider.  
When the mouse button is released, the window will be redisplayed with the new 
size and shape.  This may mean changes in the displayed proportions of the graph 
and the data table.  You can use the Pane Control to adjust the size of the graph and 
data table.  (See the discussion of the data table in the Reference section for more 
information on using the pane control.)

Printing Windows

If you have a printer attached to your computer, you can always print the frontmost 
(active) window by holding down three keys simultaneously:  the Shift key, the 
Command key(), and the number "4" key.   If you also press the Caps Lock key, the 
entire computer screen will be printed.  These procedures are not only part of Axon , 
but are characteristic of every Macintosh program.

You can also print the notepad window by making the notepad the active window 
and choosing Print Notepad from the File menu.

Shortcuts

To identify a data trace, hold the mouse down on a data table column heading.

To send a window behind all other windows, Option-Click on its title bar.

To copy a picture of the screen to a disk file use Command-Shift-3.  You can create 
up to ten files, automatically named named ‘Screen 0’ through 'Screen 9' 

To print a picture of the current window, use Command-Shift-4. (Requires that a 
printer be attached).  

To print the entire screen, depressed the caps-lock key and use Command-Shift-4.



To stay in help mode, hold down the option key while clicking 

When Memory is Low

If you get a message warning that memory is low you should take the warning 
seriously.  Make sure that you have exported any data you will want later. (Use Copy 
Data To File, Copy Window Data, Copy Window Graph, and Copy Window.  Print or 
copy your Notepad.  See Communicating With Other Programs above or check the 
index under Exporting Data.)

The program may not be making use of all the memory available on your 
Macintosh.  You can tell it to use more of the available memory in the following 
way.

• Quit from the program (after exporting your data)

• Select the program's icon and choose Get Info from the Finder’s File menu.

• There is a box in the lower right hand corner of the Get Info window that 
shows how much memory the program is requesting.  If you have enough memory, 
increase this number.

• Restart the program. 

Editing the Problems

Problem editing allows you to customize a problem to meet your specific needs.  
You can edit an existing problem or create an entirely new one.  Using this utility 
you can change the characteristics of the experiment parameters to simulate a 
particular model, create simple or complex problems by hiding/showing 
parameters, and customize the appearance of the data table and the Summary 
Window.  Once you have set up a problem, it will be saved and all simulations run 
from the problem will start with the same set of initial conditions.

Selecting a Problem to Edit

If your version of the Axon program supports problem editing, when you start up 
you will see the Edit Buttons to the left of your startup screen, as in Figure 43 below.



Figure 43
Problem Selection screen, with editing enabled.

The list of problems within a copy of the program can be manipulated in three ways:

Edit Problem  Select a problem from the problem list on the left and click Edit 
Problem to edit its settings.  This will give you an opportunity to make changes to 
the problem you have selected.  However, the original version of the problem will 
be overwritten by the changed version.  If you don't want to lose the original 
version, use the New Problem option instead of Edit Problem.

New Problem . Click New Problem to define settings for a new problem.  You will be 
given a default, untitled problem which you can configure in any way you want.

Delete Problem. Clicking on Delete Problem will permanently remove the selected 
problem from the list of problems.

Sometimes you might want to create copies of Axon which have problem editing 
disabled so as to prevent users from looking at the description of a problem they are 
trying to solve or just to present a less complicated program.  You can use the 
R e m o v e  button at the bottom of the screen to delete the problem editing capability 
from this copy of the Axon.  Caution:  this is a permanent change.  Be sure you keep 
a backup copy of Axon with problem editing intact.  One technique is to keep a "for 
editing" copy of Axon.  When you want to create or change a problem set, make a 
copy of the "for editing" Axon and use this copy to create your new problem set.  
You can then safely remove the editing capability from this copy if you wish.

The Problem Editing Window



If you click on either the Edit Problem button or the New Problem button, the 
Problem Selection Window will be replaced by the Problem Editing Window, Figure 
44.  This window is similar to the Experiment Summary window in appearance.  
Any changes which you make in the problem will be reflected in the appearance of 
the window so that you can see what the final problem will look like.

Figure 44.
The Problem Editing Window.

You can use the pane control to change the relative sizes of the graph and the data 
table.  (See Problem Options below to hide/show the data table).  You can also use 
the Grow Box in the lower right-hand corner to change the size of the window.  
These changes will be saved when you exit problem editing.

In the bottom right corner of the window are two control buttons:

Done Button.  When you are finished editing the problem, click on the Done 
button.  All of the changes to your problem will be saved and you will be returned to 
the Problem Selection Screen.

Reset Button.  Clicking on the Reset button will erase all of the changes which you 



have made to the problem and return you to the configuration it had when you 
opened it.

Problem Configuration Options

Along the bottom of the window on the left are the Problem Configuration Options 
(Figure 45).

Configuration Options

Graphs Popup Menu

Figure 45.
The Problem Configuration Options.

Options.   Clicking on this button will put up a Problem Options window (Figure 46) 
which allows modification of some of the characteristics of the model:

Figure 46
The Problem Options Window.

Model Name:  Select the entry and type a new name for this problem.

Simulation Control:  Enter new values for the size of the Time Step in this problem 
and the frequency of data sampling.  These values will affect the speed and accuracy 
of the simulation. 

Include in Model:  Choose whether or not to include Na and/or K gates in the 
model.



Parameters. Use this popup menu to choose which of the experiment parameters 
the user will have control over.  If an item is checked, a control for that item will 
appear in the summary window, either in the Control Panel or in the membrane 
cartoon.  Figure 47 shows the items in this popup menu.

Figure 47.
The Parameters popup menu

The first four items deal with the controls for intra- and extracellular ionic 
concentrations.  They have been made permanently inactive in this version of 
Axon, but they will be available in later versions.

The next three items turn on/off the controls for the stimuli and clamps.  The last 
four items turn on/off the display of controls which will appear in the control 
panel.  These controls cannot be displayed if the membrane cartoon is also displayed.  
Choosing to display the membrane control (see Layout, below) will turn these items 
off.

Layout:  Use this popup menu to choose whether or not to display the data table, the 
control panel, and the membrane cartoon.  Both the control panel and the 
membrane cartoon cannot be displayed at once — turning one on will toggle the 
other off.

Data:  Use this popup menu to set the data items which will appear in the Graphs 
menu in the menu bar.  These items will also be included in the data table, if there 
is one.  This menu controls only whether or not the items will be listed in the 
Graphs menu.  Use the menu itself to choose which will be the items that will be 
plotted in the default graph.



Graph Menu

The Graph menu at the top of the screen can be used to set up the default graph.  
Clicking on one of the data items in the first section of the menu will toggle a check 
mark off and on.  When the check mark is on, the data item will be plotted on the 
default graph when the simulation is run; when there is no check mark, the data 
will not be plotted.

The Set Graph Scales item will put up a widow which allows you to change the y-
axis scale for any of the data items listed in the menu.  See the discussion of Graph 
Scaling in the Overview of Axon section of the Reference section for more 
information on using the Graph Scaling window.
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Glossary

Axon A peripheral nerve.  In the context of this program, a 
simulated excised peripheral nerve from a squid.

Capacitance In the resting nerve cell electrical attraction causes 
negative charge to accumulate against the inside of the 
cell membrane and positive charge against the outside.  
Thus, the membrane acts just like an electrical capacitor 
with the lipid matrix of the membrane being the 
dielectric.  Capacitance is defined as dQ/dE, the amount of 
charge (Q) that must flow to cause a 1 volt change in 
potential (E) difference.  The capacitance of the axon 
membrane is about 1 microfarad per square centimeter.

Clipboard The clipboard is an invisible place where something 
(usually a picture or a few words) can be stored for a 
moment.  When you Copy  text you put it on the 
clipboard.  When you Paste  you are pulling something off 
the clipboard to insert it into a document.  The clipboard is 
part of the computer, not part of the particular program 
you are using, so you can use it to transfer information 
from one program to another. 

Conductance The conductance of an ion is the reciprocal of its electrical 
resistance in a membrane and is a measure of membrane 
permeability to that ion. The net current of an ion is equal 
to its conductance times its electro- chemical driving force.  
The unit of conductance, the mmho, is the reciprocal of 
the unit of resistance, the milliOhm (mOhm).

Current The net current (i) of an ion across a membrane is equal to 
the electro-chemical driving force on the ion times the 
conductance of the membrane for that ion, e.g.

1. iNa = gNa (E - ENa)

where iNa is the Na+ current, gNa is the Na+ 
conductance, E is the membrane potential and ENa is the 
equilibrium potential for Na+ (which can be derived from 
the Nernst equation).



The convention used here is that a negative current is the 
flow of positive charge into the cell.

Customize The ability to change parts of the program to better fit your 
needs and instructional objectives.  In Axon you can use 
the Problem Editing facility to change the experiment 
parameters, the layout of the Experiment Summary 
Window, the name of the problem, etc.

Dialog Box A window that contains requests for instructions or 
information.  For instructions on using dialog boxes see 
your Macintosh Owner's Guide.

E Graphing variable representing membrane potential.

Experiment
Summary
Window Associated with each Axon experiment is an Experiment

Summary Window.  Using the tools in this window, the 
experimenter can set up the experiment parameters, run 
one or more experiment trials, and display the results.  
Once the experiment has been run, the window's tools 
can be used to look at the data in different ways, take notes 
on the experiment, and export the notes or the data to 
other programs for further analysis.  

F_Na Graphing variable representing the probability (multiplied 
by 100) of finding a fast Na gate open.

gK Graphing variable representing K+ conductance.

gNa Graphing variable representing Na+ conductance.

iK Graphing variable representing K+ current.

iLeak Graphing variable representing leakage current.

iNa Graphing variable representing Na+ current.

iNet Graphing variable representing net current.

iStim  Graphing variable representing stimulating current.

Membrane 
Potential The two basic means by which membrane potentials 

develop are 1) active transport of ions across a membrane 
and 2) diffusion of ions through a membrane, where both 
create an imbalance of charge.  In the resting nerve cell 3 



Na+ ions are pumped outward for every 2 K+ ions 
pumped in.  In addition, because the resting membrane is 
far more permeable to K+ than Na+, K+ diffuses out of 
the cell faster than Na+ can diffuse in.  Since the 
membrane is relatively impermeable to inside anions, 
these two factors create a negative internal environment.

When the active transport of Na+ out of the cell is exactly 
opposed by its inward diffusion, and the transport of K+ 
in is equally opposed by its diffusion out, the membrane is 
at its resting potential.

The change in membrane potential (dE) over a time 
period (dT) can be calculated by the equation

2. dE = (iT x dT)/C \n

where iT is the total current and C is the capacitance of the 
membrane.

Menu At the very top of your Macintosh computer screen  there 
is a white bar with a number of symbols and words.  This 
is called the Menu Bar, and each of the symbols and words 
is the title of a menu.  For more information about menus 
and how to use them, see your Macintosh Owner's Guide.

Mouse Please see your Macintosh Owner's Guide for information 
about what a mouse is and how you use it.

Nernst Equation The Nernst equation is

3. Ea - Eb = (RT / ZF) ln([x]b / [x]a)

where R is the gas constant, T is absolute temperature, Z is 
the valence of the ion, and F is the Faraday.

The Nernst Equation allows one to compute the electrical 
potential difference, Ea-Eb, required to produce an 
electrical force, ZF(Ea-Eb), that is equal and opposite to the 
concentration force, RTln([x]a/[x]b), tending to move an 
ion, x, from a to b.  It is valid only for ions at equilibrium.

Using a temperature of 37° C (body temp.), converting to 
log base 10 and substituting numbers for some of the 
constants we get the simpler equation

4. Ea-Eb=(-61/Z)log([x]a/[x]b)\n



Thus, for an ion x+, if the concentration ratio is 101 the 
equilibrium  potential for x+ is -61 mvolts.  At this 
membrane potential there is no net x+ current.

Notepad A notepad is a window that you can type into, or insert 
pictures into.  It is a place to write notes to yourself, or to 
collect your thoughts for a lab report.  Each window has a 

associated notepad, to open it, click on the  symbol in 
the upper left of the window.

Problem A problem in Axon represents a micro-world within 
which you can formulate an hypothesis, design 
experiments to test your hypothesis, and organize and 
evaluate your data.  Different problems will probably 
include different subsets of the experiment parameters 
available in Axon, allowing you to investigate different 
aspects of nerve physiology, or they may make different 
tools available for you to use. 

S_K Graphing variable representing the probability (multiplied 
by 100) of finding a slow K gate open.

S_Na Graphing variable representing the probability (multiplied 
by 100) of finding a slow Na gate open.

Scrapbook The scrapbook is a desk accessory that will store more than 
one thing for you.  This is an advantage over the clipboard 
which can only store one thing at a time.  See  your 
Macintosh Owner's Guide for more information on desk 
accessories and the scrapbook.

Window A window is an area of the computer screen, usually 
rectangular, that displays information.  Most windows 
have a title displayed at the top.  For more information 
see your Macintosh Owner's Guide.



Appendix A - Hardware and Software Requirements

Axon requires a Mac Plus or later Macintosh computer running System 6.05 or later.  
To tell what system you are running, choose the About the Finder item from the 
Apple ( ) menu.  You must be at the Desktop, or Finder, level — that is, at the level 
you start in when you power up your Macintosh.



Appendix B - It Doesn't Work!

The program won't run.

Check to make sure you are using the correct hardware and software.  See the 
section on Hardware and Software Requirements.

You may have an incompatibility with an Init (a program which runs automatically 
when you start up you Mac) or a Desk Accessory.  Try removing all inits.  If the 
program runs, put the Inits back one by one until you find the one that is a problem.  
If you do find a problem with an Init, please let us know.

The program doesn't look like the picture in the manual.

Perhaps the problem you are looking at is not setup in the same way as the problem 
pictured in the manual.  See A Word of Warning at the beginning of the manual.

Perhaps you have an earlier/later version of the program.  This manual was written 
for Version 1.B03.

It doesn't work the way I expected it to.

Check the reference section to make sure you are using the program correctly.



Appendix C - Exercises

Exercise 1 - Classical Stimulus Response
Characteristics

This first exercise illustrates some of the classical stimulus response characteristics of 
axons.  In particular we shall study the properties of threshold stimuli, the all or 
none response, and the refractory period.

Threshold stimulus intensity

Open Exercise 1.  Click on the Start button and record a typical response (action 
potential).  Now click on the New button for another trial.  This time reduce the size 
of the stimulus to a very low, subthreshold level (say 10 µa) while keeping the 
stimulus duration constant at 0.1 msec.  No response occurs.  Now by producing 
various sized stimuli, find the threshold that is just able to produce an action 
potential.  Keep the duration constant at 0.1 msec.  Although changes in stimulus 
strength can be brought about by dragging the stimulus handle it is  more accurate in 
this case to enter numbers directly from the keyboard.  (Click on the intensity box 
and type in your number).  Accuracy to two significant figures should be sufficient.  
To save time, it is not necessary to record the entire response; once it is obvious that 
an action is developing (i.e., your stimulus is above threshold), you can terminate 
the run by clicking the stop button.

All or None

Note that although the response time varies with the stimulus strength, for all 
stimuli > threshold, the size and shape of the action potential remains constant.  
Excitation is all – or – none.

Strength Duration

Change the stimulus duration to say 0.2 msec. and find the new threshold  that 
corresponds to that duration.  Repeat this several times, using different values for 
the duration to accumulate a table showing how threshold stimulus intensity is 



related to the duration.  Hand plot a graph showing threshold on the y-axis, 
duration on the x-axis.  This yields a classical  ”strength - duration” curve.

(Remember that you can use the Notepad to take notes on your experiment, the 
Save Window Data command (in the File menu) to save your data to a file, and the 
Copy Window Graph  command (in the Edit menu) to copy a picture of the current 
graph.  You can then print the Notepad, import your data file to another program, 
such as Excel, or paste the picture of your graph in the Notepad or into another 
program.  See the Reference section of the Axon manual for more details on using 
these, and other tools, to help you analyze your data.)

Refractory Period

To prepare for this, first click on the New  button and then select the time scale box 
(way over on the right, under the graph) and enter 20.  The longer time scale allows 
more time to see results of multiple stimuli.  In the lower left locate the “Stimulus 
Well”, a box containing both square and triangular “handles”.  Drag one of these 
square handles to some position, say 8 msec., on the time axis.  You now have two 
stimuli set up, one starting at 0.5 msec., the other at 8 msec.  Both stimuli should 
have equal intensities and durations ( -100 and 0.1 respectively).  You can control 
each of these stimuli using the numeric controls in the stimulus control panel 
under the graph.  Click on the first one, and the control panel boxes “Start”, 
“Intensity”, and “Duration” refer to it.  Click on the second stimulus and the control 
panel boxes reflect the parameters of the second stimulus.  Initiate this simulation 
by clicking on Start.  (If the screen is too cluttered, select Hide All Back from the 
Visible Graphs menu.)  The first stimulus was effective, but the second was not 
because it fell within the refractory period of the first.  Now set the second stimulus 
father away from the first, say at 16 msec., and initiate the simulation.  Apparently 
the axon has “recovered” by 16 msec. because the second stimulus is effective.  But 
the latent period (time between the stimulus and  onset of response) is slightly 
prolonged so that the axon has not completely returned to its original state.  One 
way to study refractory periods is to measure the threshold at various times 
following the first action potential (e.g. select a start time for stimulus #2 and vary 
its amplitude until you find the threshold.  Repeat for several different start times.)  
The graph scales for the stimulus are set between -200 and +200.  You can enlarge the 
range of stimuli available to you by selecting scales from the graph menu and 
increasing the range of iStim.



Exercise #2 - Inexcitable Axon

Open Exercise #2.  In this exercise we will stimulate a primitive inexcitable axon.  It 
leaks Na, K, and possibly other ions through inert channels, but these channels 
have no voltage activated gates; the channels do not open or close in response to 
membrane voltages.  The axon has a normal ion distribution (high K on the inside 
and high Na on the outside).  It has a nearly normal resting potential because K ions 
leak out faster than Na ions leak in (it is more permeable to K than to Na).  
Remember that, by convention, the membrane voltage E always refers to the inside 
of the cell.  If E is negative, the inside is electrically negative compared to the 
outside.  Conversely, when E is positive the inside is electrically positive compared 
to the outside.  This simulation shows the basic properties of a leaky membrane.  In 
the Exercises  3 and 3A we will superimpose voltage activated channels.

This Axon is Inexcitable

Stimulate the axon with the indicated standard stimulus (-100, 0.1).  Increase the size 
and/or duration of the stimulus.  Can you elicit an action potential?  Change the 
sign of the stimulus (e.g. to +100, 0.1).

The Response is Symmetrical

Notice that the response is symmetrical; if you change the sign of the stimulus, the 
response also changes sign but has the same size and shape.  In the normal excitable 
axon this symmetry is absent.

The Response is Linear

Make the stimulus duration much longer (e.g. greater than 2 msec.) so that the 
response will have sufficient time to fully develop.  Keep this new duration 
constant, and vary the amplitude to show that the fully developed response is 
proportional to the stimulus amplitude.  (e. g. hand plot a graph of response vs. 
stimulus amplitude and show that the points fall on a straight line).  Unlike a 
normal axon, the response is not all – or – none.  Further there is no threshold.  
Finally, by using two stimuli, show that no matter when you apply the second 
stimulus the same final response will be elicited i. e. there is no refractory period.

(Remember that you can use the Notepad to take notes on your experiment, the 



Save Window Data command (in the File menu) to save your data to a file, and the 
Copy Window Graph  command (in the Edit menu) to copy a picture of the current 
graph.  You can then print the Notepad, import your data file to another program, 
such as Excel, or paste the picture of your graph in the Notepad or into another 
program.  See the Reference section of the Axon manual for more details on using 
these, and other tools, to help you analyze your data.)

The Response Time Depends on the Membrane Capacitance

The membrane capacitance is a measure of the amount of charge that must be added 
to the membrane to increase its potential (E) by 1 volt.  If the capacitance is large, 
delivery of more charge will be required to raise E, and we may expect it to take a 
longer time to arrive at a given value.  Verify this in your simulation by changing 
the membrane capacitance.  If time permits hand plot the half time (time required 
for the response to arrive at 50% of its final value) vs. membrane capacitance. 

ALTERNATIVE: Simply ask the student to demonstrate whether this axon has a 
threshold, all – or – none response, and refractory period.



Exercise #3 - Na Channels Blocked

Open Exercise #3.  This exercise simulates an axon that has intact voltage activated 
potassium (K) channels, but no voltage activated sodium (Na) channels.

Stimulate this axon and compare it with the results in Exercise #2 (leaky axon 
without any voltage activated channels).  Use both short and long stimuli of various 
sizes.  Drag the graph cursor (vertical dashed line) back and forth and use the screen 
cartoon (described below) to help interpret your results.  

Description of Screen Cartoon: 

Figure 1 show the membrane cartoon with only the potassium (K) channels drawn.  
(Other exercises or problems may have cartoons which show both Na and K gates 
(e.g. Exercise 5) or just Na gates (e.g. Exercise 4).)

Potassium ions
 inside cell

Open K Channels

Electrical Force

Closed K Channels

membrane

outside

inside

Concentration Gradient 
(Diffusion Force)

Figure 1

The thick black line represents the axon plasma membrane.   The high K 
concentration is shown on the inside of the cell, poised to exit.  There are two 
arrows associated with the K ion, the black arrow represents the electrical force 
acting on each ion tending to move it across  the membrane.  The gray arrow 
representing the diffusion force or the tendency of the K ion to diffuse across the 
membrane, out of the cell, down its concentration gradient.  An arrow pointing 
upwards denotes a force on the ion pushing it out of the cell.  A downward arrow 
pushes into the cell.  The net force on the ion is the algebraic sum of the two forces 



(gray “concentration” arrow minus black “electric” arrow).

There are two requirements for the net flow of an ion through a membrane. 
1.  There has to be a net force in the direction of flow 
2.  There has to be an open pathway (or channel) through the membrane. 

In Figure 1, open channels are represented by the continuous gray lines extending 
across the membrane.  Lines that do not extend across the membrane are closed 
channels.   (The number of continuous lines is proportional to the conductance (gK) 

which can be plotted or read numerically from the table. )  To form a mental image 
of these channels it is helpful to imagine that they are regulated by voltage activated 
"gates" which open or close in response to changes in membrane potential or 
voltage (Figure 2).  

K+ K+

magnify
open  

channel

magnify
closed 
channel

Figure 2
Potassium gates.

Each K channel contains a single gate which blocks the K channel when it is closed. 
Some of these gates are open and some are closed at any particular  membrane 
potential (voltage), but as the voltage becomes more positive, more gates are found 
in the open position.  



Look at the trials you have run for this exercise.  Note that during a long stimulus, E 
first rises and then falls to a lower level, even though the stimulus is maintained.  
This is due to the “sluggish” voltage activated K channels finally opening in 
response to a depolarization (stimulus causing E to rise and become less negative).  
This allows K to leave the cell more rapidly, leaving uncompensated negative 
charge behind.  Correlate this response with the opening of K channels shown in 
the cartoon.  (You may have to use large stimuli for the K channels to show up in 
the cartoon).  Once activated, the K channels are also slow to turn off when the 
stimulus is removed.  This is apparent in the graph, where E drops slightly below its 
resting value and only slowly returns as the channels resume their resting 
configuration. Correlate this with the closing of K channels in the cartoon.  This 
slow return of the K channels to their resting state is related to the refractory period 
seen in the normal axon.  Use dual stimuli to illustrate this.  When the two long 
stimuli are applied close together, the peak response of the second stimulus will be 
lower than the response to the first. 

Although this simulation shows K gates opening and closing  in response to 
changes in E , it is difficult to interpret any detailed information (e.g. how many 
gates open and how fast) because E keeps changing.  Exercise 3A illustrates an 
experimental technique designed to overcome this complication.  Instead of 
applying an ordinary rectangular shaped stimulus of constant height and allowing E 
to respond, E is set at a given level and forced to remain constant at that level by 
continuously varying the magnitude  of the "stimulating" current.  



Exercise 3A - Voltage Clamp for K Channel

Open Exercise 3A.  This exercise is not set up to stimulate the axon and observe the 
resulting membrane voltage (action potential).  Instead, you will:

1. jump the membrane voltage to a pre-determined level
2.  hold it fixed at that level 
3. record the ion flow through the membrane that is required to keep the 

membrane voltage from moving. 

This experimental arrangement, called a voltage clamp, is one of the most valuable 
experimental techniques in neurophysiology.  It allows you to change the voltage 
and hold it at a set value - not letting it run away as it normally does when you 
stimulate it.  This is exactly what is required for a careful study of what happens on 
depolarization (stimulation).  Depolarization is the force which opens or closes 
gates.  You can choose the size of the depolarization and it will stay where you put it, 
while you monitor the flow of ions (current) through the membrane.  
Measurements of ion flow through the membrane can then be used to make 
inferences about gates opening or closing under your prescribed force (membrane 
voltage).  The experiment is illustrated below.

Illustration of Voltage Clamp Experiment

At rest the concentration gradient (gray arrow) causing K+ to diffuse out of the cell is 
nearly balanced by the electrical force (membrane voltage , black arrow) acting in the 
opposite direction. As a result very little K+ leaks out.   See Figure 3, below.
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Figure 3 
Forces acting on the K+ ions.

When the voltage clamp is turned on, a small pulse of negative charge is delivered 
to the external membrane surface (an equivalent positive charge is also delivered to 
the internal surface).  This new charge is just sufficient to jump the membrane 
potential from -65 mv to -20 mv.  See Figure 4, below.
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Figure 4 
The voltage clamp has been turned on.

This new membrane potential tending to force positive charge into the cell is too 
small to balance the tendency of K+ to diffuse out of the cell.  In addition, the 
membrane depolarization opens more  K+ channels.  K+ diffusing out of the cell 
would  add positive charge to the outside and change the membrane potential.  
However, the voltage clamp monitors E and prevents any change by adding one 
negative charge for each K+ that crosses the membrane to leave the cell (Figure 5).  
(The negative charge added to the solution is an ion not a bare electron. The identity 
of the ion depends on the type of electrode and need not concern us).  We have not 
shown the intracellular electrode which acts in a similar way by "absorbing" the 
excess negative charges (ions) left behind by K+ when it moves to the outside.
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Figure 5 
K channels open in response to depolarization.

The value of the voltage clamp is due to the fact that with modern technology it is 
not possible to chemically measure the small amounts of K that enter or leave the 
cell within a fraction of a msec., but the charge delivered by the voltage clamp can be 
measured routinely.

Run the Simulation

The screen is set to begin the clamp at 3 msec by "jumping" the membrane potential 
E from -65 mv to -20 mv and keeping it at this value for 12 msec.  Run the 
simulation.  Drag the graph cursor (vertical dashed line) to different positions and 
use the cartoon to see how the K gates open in response to a sudden depolarization.  
They respond slowly.  Verify that in this case it takes them about 4 msec for half of 
those that will eventually open to respond, a substantial time compared to the time 
it takes an action potential to reach its peak.  Compare this time for half of the gates 
to open to the time required for iNet to reach half of its maximum value.  They 
should be the same because, in this case (aside from a very small leakage 
component) iNet is proportional to the number of open K channels.  "In this case" 
refers to the facts that:

1. There are no operating Na channels.  Therefore ion flow through the 
membrane is practically all due to K ions.

2. The membrane potential is clamped at a given value and does not change. 
Since the K concentrations also do not change within the short time (12 msec) of the 



clamp, it follows that none of the driving forces for ion flow change.  The only way 
for iNet to change is by changing the number of open channels.

Using this voltage clamp setup, the effects of depolarization on opening (or closing) 
K channels can be studied in detail.   

Keeping the duration of the clamp constant, run 7 or 8 different experiments with 
different values of the clamped voltage, spanning the range between, say, -80 mv to 
+ 50 mv.  Plot all the iNet curves on one or two graphs, add the grid, copy your 
graphs to the Notepad, and print the results.  Assuming iK = iNet, you can use this 
data to hand plot:

1. The maximum iK obtainable at each level of depolarization.
2. The speed of response, as indicated by  the time to reach half of the 

maximal response, at each level of depolarization. 

Taken together, these two curves yield a good characterization of the K channels. 
They are useful in the understanding and development of the basis of excitation and 
they can serve as a valuable standard in diagnostic problems .

(Remember that you can use the Notepad to take notes on your experiment, the 
Save Window Data command (in the File menu) to save your data to a file, and the 
Copy Window Graph  command (in the Edit menu) to copy a picture of the current 
graph.  You can then print the Notepad, import your data file to another program, 
such as Excel, or paste the picture of your graph in the Notepad or into another 
program.  See the Reference section of the Axon manual for more details on using 
these, and other tools, to help you analyze your data.)

Using the plot of maximum iK vs. depolarization, find the membrane potential  
where maximum iK =0 (use interpolation to find this).  This is the equilibrium 
potential for K+.  It can be calculated from the internal and external K concentrations 
by use of the Nernst Equation.  Membrane potentials above this value will generate 
positive  currents sending K out of the axon, while potentials below this value 
generate negative  currents sending K into the axon.  This is true only in this special 
axon, where virtually all of the membrane current is carried by K.



Exercise #4 - K Channels Blocked

Open Exercise #4.  In this exercise all the K channels are blocked so that the only 
significant channels are Na.  (Experimentally voltage activated K channels can be 
blocked by using tetraethyl ammonium). Loss of all K channels presents a problem 
because a high K permeability is required to maintain the resting potential.  If the 
axon is depolarized at rest, many slow Na gates will be closed.  There is no possibility 
of re-opening them by further depolarization; excitation will not occur.  To 
circumvent this, the screen is setup with a voltage clamp which forces  the potential 
to remain at its normal rest value of about -65 mv until ready for stimulation.

Stimulate this axon and compare it with the results in Exercise #3 (axon K channels, 
but without any voltage activated Na channels).  Excitation occurs, but the action 
potential does not return to normal. 

After the excitation has subsided the axon remains depolarized; most fast gates are 
open but the slow gates are closed.  Drag the graph cursor (vertical dashed line) back 
and forth and use the screen cartoon (described below) to help interpret your results.  
Na channels differ from K channels; when the membrane is stimulated, the Na 
channels open very quickly, and only remain open for a very short time. You can 
also see this by plotting gNa, the Na conductance, which is proportional to the 
number of open Na channels.  This is interpreted below in terms of two voltage 
activated gates controlling the Na channel.

Note: Many axons have both Na and K channels, but in some the Na channels are 
the only ones that are voltage activated (i.e. have gates that respond to depolarizing 
the membrane).  In these cases opening of the fast Na gates is again responsible for 
the rise of  the action potential, closing of the slow Na gates is sufficient to begin the 
repolarizing phase, and the abundance of continuously open K channels is sufficient 
to return the potential to an operative resting level

Description of Screen Cartoon

Figure 6 shows the membrane cartoon with only the sodium (Na) gates drawn.  
(Other exercises or problems may have cartoons which show both Na and K gates 
(e.g. Exercise 5) or just Na gates (e.g. Exercise 3).)



Figure 6 
Membrane cartoon with only Na channels.

The continuous lines through the membrane represent open channels. The more 
lines the more channels. (The number of continuous lines is proportional to the 
conductance (gNa) which can be plotted or read numerically from the data table ).  
For K there is either a full line or no line corresponding to one gate open or closed 
(see Exercise #3).  For Na it is more complicated – there are two gates.  The slow 
gates are on the inner (bottom) side of the membrane.  When they are open they 
contribute only half a line.  The fast gates are represented on the outer (top) side of 
the membrane; they also contribute one half line. For Na to pass, you need a full 

line – both gates must be open.  The Na + gates are illustrated further in the 
following diagrams where it can be seen that any given channel has 4 possible states:

1. fast gate closed

slow gate open

2. fast gate open

slow gate open

3. fast gate open

slow gate closed

4. fast gate closed

slow gate closed

State 2 is the only open channel which permits passage of Na; all others (States 1, 3, 
and 4) are impermeable.  Figures 7, 8, 9, and 10 illustrate these four states.
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Figure 7 
State 1: Fast gates closed; Slow gates open; Na channel closed.
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Figure 8 
State 2:  Fast gates open; Slow gates open; Na channel open.
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Figure 9 
State 3:  Fast gates open; Slow gates closed; Na channel closed.
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Figure 10 
State 4:  Fast gates closed; Slow gates closed; Na channels closed.



Follow the cartoon as you drag the graph cursor and verify the following:

If the membrane is depolarized (e.g. the membrane potential is changed from the 
resting value of -65 mv to a new, less negative, value of, say, -20 mv and maintained 
at this new potential), then the response of the ion channels can be described by 
arbitrarily dividing the response into two phases: 

1.  An early response (< 1 msec) when the Na+ channels open  

2.  A late response (>1 msec) when the Na+ channels close.  Further, during 

this period the Na+ channels appear to be inactivated; they will not respond to 
further depolarization.

We can interpret these changes in terms of our hypothetical gates as follows: 

1.  Early response.  The Na+ channel contains two gates, a slow one and a fast 
one.  At rest (polarized membrane ) the slow gate is open but the rapid gate is closed 
so that the channel is closed.  Upon depolarization the rapid gate opens quickly; now 

both gates are open so that the channel is freely permeable to Na+, and Na+ rushes 
into the axon.

2. Late response. A moment later the slow Na+ gate closes.  The membrane is 

no longer highly permeable to Na+, the rapid inflow of Na+ ceases.  In this state, the 
channel will not respond to further depolarization because the slow gates are closed.



Exercise #5 - Explaining the Action Potential

Open Exercise #5.  This is a normal axon with  a full complement of voltage 
activated Na  and K channels.  Run the simulation.  Analyze your results using the 
cartoon with the Graph cursor as well as plots obtainable from the pull down Graph 
menu in the menu bar at the top of the screen.  In interpreting these data, remember 
that the amount of charge movement necessary to make substantial changes in E is 
very small.  During the short time of a single action potential, the actual amounts of 

Na+ and K+ that move in or out of the axon are very small; they have significant 

effects on E, but the concentrations of Na+ and K+ hardly change. This is illustrated 
in the program – the gray arrows  representing concentration forces do not change 
during the action potential (drag  the graph cursor back and forth) even though the 
E arrow does.

Recall that a stimulus causes a brief increase in the number of open Na+ channels.  
If the stimulus is weak, only a few channels open and the membrane is hardly 
perturbed.  However if the stimulus is sufficiently strong, i.e. if it is stronger than a 

critical level called the threshold, then the number of open Na+ channels becomes 

very substantial.  Na+ ions, poised at high concentration outside the axon, leave 
their negatively charged "partners" behind on the outside and rush in fast enough 

to overwhelm the K+ moving out.  The inside of the cell is inundated with positive 
charge so that the polarity is reversed; now the inside is positive and the outside 

negative.  A moment later the Na+ channels close and extra K+ channels open.  The 

membrane becomes very permeable to K+. K+ moves out making the membrane 

potential even more negative than it was at rest, driving it very close to the K+ 

equilibrium potential.  Finally (after several msec) the extra K+ channels  close and 
the membrane returns to its resting condition.

You can see this inflow and outflow of ions by  adding  the sodium current iNa and 
the potassium current iK to your plot (access these by using the Graph menu).    By 
convention  outward flow of positive ions ( K+ in our case) is positive, and inward 
flow (Na+ ions) is negative.  You can also plot the net current iNet to see the net 
flow of positive charge.  This will consist almost entirely of iK and iNa.  (The only 
other flow of charge is called the leakage current iLeak.  Try plotting it to show that it 
is negligible.)  When iNet is negative (positive charge flows into the cell) E will 
increase, when it is positive E will decrease.  Verify this by moving the graph cursor 
to the point where iNet just crosses the zero line and changes from negative 
(positive charge flowing in) to positive (positive charge flowing out).  At this 
moment E has reached its maximum value, moments before it was increasing, 
moments later it will decrease.  (You can use the iStim graph (during the time when 
the stimulus is off) as a convenient marker for the zero  line.)



Note how small the stimulating current is compared to the sodium or potassium 
currents, or even the net current.  It gives some indication that the axon is “loaded” 
with its own energy source ( ion gradients that have been set up by the pump) and 
ready to be triggered off by a small disturbance.  In making this comparison, be sure 
to  account for the graph scaling.  Select Set Graph Scales from the Graph menu and 
notice that the scaling is identical (-1000 min :1000 max) for iNet, iK, and iNa.  
However  iStim is plotted on a scale that is 5 times more sensitive.  Change its 
scaling from (-200 min : 200 max) to (-1000 min : 1000 max) making it compatible 
with the other currents.  Click on Apply and close the scaling window by clicking on 
the close box (upper right hand corner).  It is now apparent that a relatively small 
current stimulus evokes an enormous response of membrane currents, 
emphasizing the explosive nature of the excitatory process.

Opening  and closing of gates depends on E

The behavior of the axon is governed almost entirely by the precise timing of Na 
and K gates as they open and/or close in response to changes in membrane potential 
(E).  The cartoon gives a visual picture of the position of these gates at any particular 
time  The following table is a simple qualitative reminder about how these gates 
respond to changes in E (membrane potential)

       Gate   Speed of Response       As E increases
 (becomes more positive)       As E decreases
 (becomes more negative)

K Slow OpensCloses
Fast Na Fast OpensCloses
Slow Na Slow ClosesOpens

Move the graph cursor around and try to interpret the results remembering that: 1.  
Changes in E reflect changes in net charge on the inner surface of the membrane.  2.  
Increases  in net charge are promoted primarily by positively charged Na ions 
moving into the cell and opposed by positively charged K ions moving out.  3.  
Movements of Na or  K are determined by the net force on the ion as well as the 
number of channels that are open to that ion.  4.  BOTH the fast AND slow Na gates 
must be open in the same channel in order for the channel to be open.

At rest, the membrane is polarized.  Many slow gates are open but most rapid gates 
are closed so that most channels are closed.  If the membrane is stimulated, its 
response can be divided into 3 phases:

1. An early response when the rapid gates open quickly.  Na+ channels open . 

Now both gates are open so that channels become freely permeable to Na+, and Na+ 
rushes into the axon causing E to rise in the positive direction.



2. A late response; A moment later the slow Na+ gate closes. The membrane 

is no longer highly permeable to Na+, the rapid inflow of Na+ ceases.  In addition 

the slowly responding gates in the K+ channel open and K+ flows out of the axon, 
causing E to fall in the negative direction.

3. A recovery phase when all gates return to their original resting position.

Threshold, All-or-None, Refractory Period

1. Threshold.  If a nerve is stimulated with weak electrical shocks, nothing seems to 
happen.  When the stimulus is repeated many times, with each stimulus a little 
stronger than the last, eventually a point will be reached where the nerve responds 
by transmitting an action potential.  The strength of stimulus just barely able to 
excite is called the threshold. Stimuli below threshold do not work, stimuli above 
threshold produce action potentials.

2. All-or None  A stimulus above threshold excites, but the size of the response is 
independent of the strength of stimulus.  All action potentials are the same no 
matter how large the stimulus; the response is all-or-none.  This behavior is similar 
to a fuse; once lit, the size of the spark that travels along is independent of the size of 
the match that initiated it.

3. Refractory Period   The recovery period following excitation when the axon 
appears to be inexcitable is called the refractory period.

To interpret these properties, recall that the inside of the axon has high K+, the 

outside high Na+.  Further, the membrane potential is simply a measure of the 
electrical force on a positive charge.  Finally, remember that the amount of charge 
movement necessary to make substantial changes in E is very small.  During the 
short time of a single action potential, the actual amounts of Na+ and K+ that move 
in or out of the axon are very small; they have significant effects on E, but the 
concentrations of Na+ and K+ hardly change. 

At rest the axon is permeable mostly to K+, but not much K+ leaks out because the 

opposing membrane potential, E, is close to the K+ equilibrium potential (i.e. the 

concentration gradient of K+ is almost balanced by E pushing in the opposite 
direction).  Now the nerve is stimulated.  Depolarization (stimulation) has two 
effects: 

A.  Early on, voltage activated Na+ channels open. 

B.  Later Na+ channels close and K+ channels open. 

With a weak, sub threshold stimulus, not enough Na+ flows in to overcome the 



outflow of K+ and the axon repolarizes. 

With a stronger, suprathreshold, stimulus, more Na+ channels open so that Na+ 

inflow exceeds K+ outflow, the net flow of charge is now positive inward and the 

axon is depolarized even further.  But this opens even more Na+ channels which 
causes more depolarization.  A vicious cycle ensues; the membrane potential takes 
off in the positive direction with an explosive velocity as the interior of the axon 
becomes more and more positive.  But this rapid upward movement of the 
membrane potential does not persist.  Soon  E  becomes positive and large enough 

to oppose Na+ entry despite the open channels, i.e. E approaches the Na+ 

equilibrium potential (where the concentration gradient moving Na+ inward is just 

balanced by E pushing Na+ out).  At the same time the delayed effects begin to 

appear.  Na+ channels close and voltage activated K+ channels open, K+ outflow 

exceeds Na+ inflow, and the net flow of charge is now positive outward.  E 
plummets toward its resting value, overshoots momentarily and comes very close 

to the K+ equilibrium potential because the voltage activated K+ channels are still 

open making the membrane even more K+ permeable than it was at rest.  Finally 

the repolarized membrane closes the voltage activated K+ channels and E returns to 
its resting value.

From this description, we see that the threshold is determined by the stimulus 

strength that is able to cause an inward Na+ flow to just barely exceed the outward 

K+ flow.  From that point onward, the stimulus plays no further role because the 
seeds of the positive feedback (vicious cycle) reside in the axon itself.  The all-or-
none response arises naturally out of this positive feedback; once the response is 
triggered, the positive feedback drives the membrane potential to its maximum 

value (given by the Na+ equilibrium potential).  The size of the action potential is 

determined by the concentration gradients of Na+ and K+, because the 

concentration gradient of K+ determines the resting potential (K+ equilibrium 

potential) while the concentration gradient of Na+ determines the height of the 

action potential (Na+ equilibrium potential).  Just as a stick of dynamite contains its 
own explosive energy, the axon membrane is "loaded" with "explosive" energy in 
the form of ion gradients.

For a brief msec or two following excitation, the axon is no longer excitable. This 
recovery phase, called the refractory period can be divided into two phases. The 
earliest phase is the absolute refractory period where the threshold appears to be 
infinite and no stimulus will suffice.  In the later phase, the relative refractory 
period, the threshold returns to normal.  The basis for the refractory period is found 

in the "delayed effects".  After the first msec of excitation the slow Na+ gates close 
and remain closed for a brief time despite the fact that E is near rest.  These gates are 
slow to respond to the initial depolarization, and they are equally slow in 



responding to the repolarized membrane.  In addition the voltage activated K+ gates 

are still open.  With the slow Na+ gates closed and the K+ gates open, it is difficult if 

not impossible for Na+ inflow to exceed K+ outflow (i.e. to reach threshold)

How do the activities of the Na+ -K+ pump influence the action potential?  They 
don't, at least not directly.  Any contributions by the pump to  is swamped out by the 
more massive movements of the ions through the channels.  The pump does not 
cycle often enough to make a difference during activity.  However, action potentials 
are very brief and the axon is at rest most of the time.  During rest there is ample 

time for the slow cycling of the pump to restore the small amounts of Na+ and K+ 
that have leaked through channels activated during the action potential



Exercise #5A - Voltage Clamp Na and K Channels

Open Exercise #5A.  This simulates a normal axon, as in Exercise #5, under voltage 
clamp conditions, as in Exercise #3A.  (Familiarity with Exercise #3A is assumed.)  
Recall that in a voltage clamp experiment you:

1. jump the membrane voltage to a pre-determined level
2.  hold it fixed at that level 
3. record the ion flow through the membrane that is required to keep the 

membrane voltage from moving. 

Run the simulation.  While the response of the axon in Exercise #3A was governed 
exclusively by K channels, the axon in this simulation has operative Na channels as 
well as  K channels.  

Look at the gates in the cartoon as you scroll through the simulation (drag the graph 
cursor).  At the start, t=0, with no clamp turned on there are plenty of slow Na gates 
open but no fast ones.  Now move forward in time , as the clamp is turned on the 
membrane depolarizes, fast gates open and for some time ,the slow gates are also 
still open; Na can get through.  But, soon, even though the depolarization is 
maintained the slow gates close and Na can no longer pass.  At the same time open  
K channels begin to appear.  The membrane will stay in this state as long as the 
depolarization is maintained.

The experimenter actually measures the net current iNet.  Just as in 3A, iNet shows 
the charge flow required to keep the voltage at the desired value (e.g. -20 mv).  But, 
now this charge is required to balance the flow of both Na and K.  Ignoring the very 
small contribution of other ions (iLeak), we write

iNet   =   iNa + iK

In this simulation we follow the usual convention: a positive iNet corresponds to 
positive charge moving out of the cell, a negative iNet corresponds to positive 
charge moving into the cell.  The dip in the curve is negative and it corresponds to 
Na entering the cell, while the later rise is due to K leaving.  You can verify this by 
comparing this result with results obtained in Exercise #3A where Na channels 
were non-operative.  The difference between iNet in corresponding experiments in 
#3A and #5A is simply due to the flow of Na, iNa. (see Exercise #5B below)

Results obtained in these experiments provided the basis of our current 
understanding of excitation, and the voltage clamp technique remains as one of the 
most powerful analytical tools in membrane biology.  It allows you  to study in 
detail how the membrane potential governs ion channels.  In particular you can 
verify that  a sudden sustained depolarization of the membrane leads to a transient 



increase in Na+ conductance followed by a sustained increase in K+ conductance.  

The increase in Na+ conductance is attributed to the presence of two gates which 
give opposite responses to the depolarization.  The fast gate opens but the slow gate 
closes.  The time between the opening of the fast gate and the closing of the slow 

gate corresponds to the period of increased Na+ conductance.  In contrast, a K+ 
channel has only one voltage activated gate which opens (slowly).  Once open it will 
stay open as long as the depolarization is sustained. 

Immediately following the depolarization, even though the membrane potential 
has been returned to resting level (back to -65 mv), the axon is not fully recovered.  
This is because the slow gates require a msec or two to respond to the newly 
established resting potential.  If, during this brief period, a rapid second stimulus 

(depolarization) is delivered, the Na+ channels will fail to open.  The fast gates 
respond and open, but the slow gates are still closed as a result of the original 
depolarization.  Only after a recovery period of one or two msec will the slow gates 

open and allow a second stimulus to trigger the transient increase in Na+ 
conductance.



Exercise #5B

Open Exercise #5B.  This is similar to Exercise #5A except the cartoon has been 
replaced with a control panel which allows greater flexibility in controlling the 
simulation.  You can block the Na channels by setting gNa = 0, and restore them 
(gNa = 120) in the next. 



Appendix D - Axon Problems

Problems 1, 2, 3, and 4

Problems 1, 2, 3, and 4 have a common theme:  each presents a different axon with 
abnormal behavior.  Each abnormality is due to an alteration in one of the 
parameters listed in the following table:

PARAMETER REFLECTS NORMAL VALUE

gNaMax
(maximal Na conductance)
Total number of Na channels (open + closed)
120 mmho / cm2

gKMax
(maximal K conductance)
Total number of K
channels (open + closed)
36 mmho / cm2

gLeak
(leakage conductance) Total number of non-specific ion  channels
(not voltage activated)  
0.3 mmho / cm2

C
(membrane capacitance) Charge required to raise membrane potential by one volt
1.0  µf / cm2

The problem with each axon is to first identify the abnormal parameter, and then to 
determine the extent of the abnormality (i.e. the approximate numerical value of 
the altered parameter).

The only tools available to you are simulations of standard experimental 
measurements.  You can stimulate the axon ( Run Problem #1- Stim, Problem #2 - 
Stim ... etc.) or you can use a voltage clamp ( Run Problem #1-Clamp, Problem #2-
Clamp... etc.), but you are not able to call on any derived quantity such as iNa. 

Using Exercises #5 and #5A, begin your investigation by characterizing the stimulus 
and voltage clamp behavior of a normal axon.  Take copious notes and print out 
your graphical results as well as the notes.  Now run one of the problems, and, 



again, characterize stimulus and voltage clamp behavior, and print results and 
notes.  Study the differences between the two axons (e.g. threshold, shape of action 
potential, clamp behavior etc.) and describe them in your report.  After you have 
made a conjecture about which of the 4 parameters is altered, try some more 
measurements (if necessary) designed to get an estimate of how much the parameter 
deviates from normality (e.g. doubled, or cut in 1/3)  Then verify your prediction by 
running Exercise #5 B.  This setup contains a control panel which will allow you to 
alter any of these parameters.  By changing the value of the appropriate parameter 
in the control panel,  see if you can reproduce the behavior of your problem axon .  
After seeing your results, adjust  your prediction and try again. 

Your report should contain:

1. a description of the differences between the normal and problem axon -- include 
graphs plus a verbal description

2. a description of the evidence and reasons which led to your prediction.  This 
should include a qualitative discussion of the basis for each of the differences in 
behavior that you observed.  (It may be useful to study your reconstruction of the 
altered axon with the setup in Exercise 5B to help resolve trickier points that may 
arise – Exercise 5B allows access to all derived quantities) 

Problem #5

The object of this problem is to investigate effects of hyper-polarizing stimuli and 
currents (i.e. those stimuli or currents that  drive the E in the negative direction).  
Open Exercise #5. and  change the time base from 10 to 15 msec.  Also change 
stimulus intensity from -100 to +100 with duration remaining at 0.1 msec, and run 
the simulation.  Nothing interesting.  But, keep the stimulus intensity at +100 and 
increase the duration from 0.1 to 1.0 msec. The axon responds with a delayed action 
potential – long after the stimulus has been removed.  This is characteristic of the 
action of hyper-polarizing stimuli.  Excitation only occurs (if at all) after the 
stimulus has been removed.  You can compare this to corresponding de-polarizing 
stimuli by maintaining the long duration (1 msec. ) and changing the intensity back 
to -100.  Excitation now occurs during the stimulus.

How can hyper-polarizing stimuli excite?  Investigate this phenomena – that means 
think about it and play with it.  Try out your hunches.  Use Exercise #5A or #5B to 
study effects of hyper-polarizing voltages (i.e. E made more negative than the 
normal resting potential), and pay particular attention to the behavior of the gates.  
Remember that excitation requires a net inward flow of positive charge.  Describe 
your results and try to form a qualitative idea of the mechanism of this response.

Related problem:.  Open Exercise 4 and either remove the stimulus by dragging it off 
the screen or simply set the stimulus intensity = 0.  Be careful to leave the clamp 
parameters unchanged.  Run the simulation.  Excitation occurs!  Investigate and 



explain your results.
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